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About This Guide

Use this guide as an overview of Leopard Server security 
features that can enhance security on your computer.

This guide gives instructions for securing Leopard Server or later, and for securely 
managing servers and clients in a networked environment. It also provides information 
about the many roles Leopard Server can assume in a network.

Target Audience
Administrators of server computers running Leopard Server or later are the intended 
audience for this guide. 

If you�re using this guide, you should be an experienced Leopard Server user, be 
familiar with the Workgroup Manager and Server Admin applications, and have at least 
some experience using the Terminal application�s command-line interface. 

You should also have experience administering a network, be familiar with basic 
networking concepts, and be familiar with the Leopard Server administration guides.

Some instructions in this guide are complex, and deviation from them could result in 
serious adverse effects on the server and its security. These instructions should only be 
used by experienced Leopard Server administrators, and should be followed by 
thorough testing. 

What�s New in Leopard Server
Server Leopard offers major security enhancements in the following key areas:
Â Better Trojan horse protection.  Leopard Server marks files that are downloaded to 

help prevent users from inadvertently running malicious downloaded applications.
Â Stronger runtime security.  New technologies such as library randomization 

and sandboxing help prevent attacks that try to hijack or modify the software on 
your system.
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Â Easier network security.  After you�ve activated the new Leopard Server application 
firewall, it configures itself so you get the benefits of firewall protection without 
needing to understand the details of network ports and protocols.

Â Improved secure connectivity.  Virtual private network (VPN) support has been 
enhanced to connect to more of the most popular VPN servers�without additional 
software.

Â Meaningful security alerts.  When users receive security alerts and questions too 
frequently, they can fall into reflexive mode when the system asks a security-related 
question, clicking OK without thought. Leopard Server is designed to minimize the 
number of security alerts that you see, so when you do see one, it gets your 
attention.

What�s in This Guide
This guide explains how to secure servers and securely manage server and client 
computers in a networked environment. It does not provide information about 
securing clients. For help with securing computers running Mac OS X v10.5 Leopard 
or later, see Mac OS X Security Configuration.

This guide cannot cover all possible network configurations in which Leopard Server 
might be used. Good network security and design must be used for this information 
to be effective, and anyone using this guide needs to be familiar with UNIX security 
basics, such as setting file permissions.

This guide includes the following chapters, arranged in the order that you�re likely to 
need them when securely configuring a server. 
Â Chapter 1, �Introduction to Leopard Server Security Architecture,� provides an 

overview of the security architecture and features of Leopard Server. This chapter 
describes the security framework, access permissions, built-in security services, and 
directory services.

Â Chapter 2, �Installing Leopard Server,� describes how to securely install 
Leopard Server locally or remotely. This chapter also includes information about 
updating system software, repairing disk permissions, and securely erasing data.

Â Chapter 3, �Protecting System Hardware,� describes how to physically protect your 
hardware from attacks. 

Â Chapter 4, �Securing Global System Settings,� describes how to secure settings that 
affect all users of the computer.

Â Chapter 5, �Securing Local Server Accounts,� describes the types of user accounts and 
how to securely configure an account. This includes securing accounts using strong 
authentication. 
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Â Chapter 6, �Securing System Preferences,� helps you configure your local server 
accounts securely. This includes the secure configuration of local system preferences, 
setting up strong authentication and credential storage, and securing data.

Â Chapter 7, �Securing Data and Using Encryption,� describes how to encrypt data and 
how to use secure erase to ensure old data is completely removed.

Â Chapter 8, �Securing System Swap and Hibernation Storage,� describes how to scrub 
your system swap and hibernation space of sensitive information.

Â Chapter 9, �Avoiding Simultaneous Local Account Access,� describes how to protect 
your data from the security vulnerabilities of multiple users using single accounts.

Â Chapter 10, �Ensuring Data Integrity with Backups,� describes the Time Machine 
architecture and how to securely back up and restore your computer and data.

Â Chapter 11, �Securing Accounts and Share Points,� describes security settings related 
to managed user and group accounts. 

Â Chapter 12, �Managing Certificates,� describes how to generate, request, and deploy 
certificates.

Â Chapter 13, �Setting General Protocols and Access to Services,� helps you configure 
general network management protocols and restrict access to other services.

Â Chapter 14, �Securing Remote Access Services,� tells you how to create remote 
connections to your server using encryption.

Â Chapter 15, �Securing Network and Host Access Services,� explains how to connect 
client computers and configure a firewall.

Â Chapter 16, �Securing Collaboration Services,� describes how to securely configure 
iChat, iCal, Wiki, and Podcast Producer services.

Â Chapter 17, �Securing Mail Service,� explains how to set up mail service to use 
encryption and filter for spam and viruses.

Â Chapter 18, �Securing Antivirus Services,� describes how to enable and manage 
antivirus services to protect your mail and files.

Â Chapter 19, �Securing File Services,� explains how to configure file services to enable 
secure data sharing.

Â Chapter 20, �Securing Web Service,� describes how to set up a web server and secure 
web settings and components.

Â Chapter 21, �Securing Client Configuration Management Services,� helps you set 
policies and enforce them using Workgroup Manager.

Â Chapter 22, �Securing NetBoot Service,� tells you how to configure NetBoot securely 
to provide images to clients.

Â Chapter 23, �Securing Software Update Service,� describes how to securely configure 
software update services.

Â Chapter 24, �Securing Directory Services,� explains how to configure Open Directory 
service roles and password policies.
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Â Chapter 25, �Securing RADIUS Service,� tells how to securely configure the RADIUS 
service.

Â Chapter 26, �Securing Print Service,� explains how to set up print queues and banner 
pages.

Â Chapter 27, �Securing Multimedia Services,� provides security information to 
configure a streaming server.

Â Chapter 28, �Securing Grid and Cluster Computing Services,� explains how to securely 
configure an Xgrid agent and controller.

Â Chapter 29, �Managing Who Can Obtain Administrative Privileges (sudo),� describes 
how to restrict access to the sudo command.

Â Chapter 30, �Managing Authorization Through Rights,� explains the policy database 
and how to control authorization by managing rights in the policy database.

Â Chapter 31, �Maintaining System Integrity,� describes how to use security audits and 
logging to validate the integrity of your server and data.

Â Chapter 32, �Configuring the IPFW2 Firewall,� describes how to configure the IPFW2 
firewall.

Â Appendix A, �Understanding Passwords and Authentication,� describes Open 
Directory authentication, shadow and crypt passwords, Kerberos, LDAP bind, and 
single sign-on.

Â Appendix B, �Security Checklist,� provides a checklist that guides you through 
securing your server.

Â Appendix C, �Scripts,� provides command-line commands and scripts for securing 
your server.

In addition, the Glossary defines terms you�ll encounter as you read this guide.

Note:  Because Apple frequently releases new versions and updates to its software, 
images shown in this book might be different from what you see on your screen.

Using This Guide
The following list contains suggestions for using this guide:
Â Read the guide in its entirety. Subsequent sections might build on information and 

recommendations discussed in prior sections.
Â The instructions in this guide should always be tested in a nonoperational 

environment before deployment. This nonoperational environment should simulate, 
as much as possible, the environment where the computer will be deployed.

Â This information is intended for computers running Leopard Server. Before securely 
configuring a server, determine what function that particular server will perform and 
apply security configurations where applicable.
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Â Use the security checklist in Appendix B to track and record each security task and 
note what settings you changed. This information can be helpful when developing 
a security standard within your organization.

Important:  Any deviation from this guide should be evaluated to determine what 
security risks it might introduce. Take measures to monitor or mitigate those risks.

Using Onscreen Help
You can get task instructions onscreen in Help Viewer while you�re managing 
Leopard Server. You can view help on a server or an administrator computer. 
(An administrator computer is a computer running Leopard Server)

To get help for an advanced configuration of Leopard Server:
m Open Server Admin or Workgroup Manager and then:

Â Use the Help menu to search for a task you want to perform.
Â Choose Help > Server Admin Help or Help > Workgroup Manager Help to browse 

and search the help topics. 

The onscreen help contains instructions taken from Server Administration and other 
advanced administration guides described in �Leopard Server Administration Guides,� 
next.

To see the most recent server help topics:
m Make sure the server or administrator computer is connected to the Internet while 

you�re getting help.

Help Viewer automatically retrieves and caches the most recent server help topics from 
the Internet. When not connected to the Internet, Help Viewer displays cached help 
topics.

Leopard Server Administration Guides
Getting Started covers installation and setup for standard and workgroup configurations 
of Mac OS X Server. For advanced configurations, Server Administration covers planning, 
installation, setup, and general server administration. A suite of additional guides, listed 
below, covers advanced planning, setup, and management of individual services. You 
can get these guides in PDF format from the Mac OS X Server documentation website:

www.apple.com/server/documentation.

http://www.apple.com/server/documentation/
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This guide� tells you how to:

Getting Started and 
Installation & Setup Worksheet

Install Leopard Server and set it up for the first time.

Command-Line Administration Install, set up, and manage Leopard Server using UNIX 
command-line tools and configuration files.

File Services Administration Share selected server volumes or folders among server clients 
using the AFP, NFS, FTP, and SMB protocols.

iCal Service Administration Set up and manage iCal shared calendar service.

iChat Service Administration Set up and manage iChat instant messaging service.

Mac OS X Security Configuration Make Mac OS X computers (clients) more secure, as required by 
enterprise and government customers.

Mac OS X Server Security 
Configuration

Make Mac OS X Server and the computer it�s installed on more 
secure, as required by enterprise and government customers.

Mail Service Administration Set up and manage IMAP, POP, and SMTP mail services on the 
server.

Network Services Administration Set up, configure, and administer DHCP, DNS, VPN, NTP, IP firewall, 
NAT, and RADIUS services on the server.

Open Directory Administration Set up and manage directory and authentication services, and 
configure clients to access directory services.

Podcast Producer Administration Set up and manage Podcast Producer service to record, process, 
and distribute podcasts.

Print Service Administration Host shared printers and manage their associated queues and print 
jobs.

QuickTime Streaming and 
Broadcasting Administration

Capture and encode QuickTime content. Set up and manage 
QuickTime streaming service to deliver media streams live or on 
demand.

Server Administration Perform advanced installation and setup of server software, and 
manage options that apply to multiple services or to the server as a 
whole.

System Imaging and Software 
Update Administration

Use NetBoot, NetInstall, and Software Update to automate the 
management of operating system and other software used by 
client computers.

Upgrading and Migrating Use data and service settings from an earlier version of Mac OS X 
Server or Windows NT.

User Management Create and manage user accounts, groups, and computers. Set up 
managed preferences for Mac OS X clients.

Web Technologies Administration Set up and manage web technologies, including web, blog, 
webmail, wiki, MySQL, PHP, Ruby on Rails, and WebDAV.

Xgrid Administration and High 
Performance Computing

Set up and manage computational clusters of Xserve systems and 
Mac computers.

Mac OS X Server Glossary Learn about terms used for server and storage products.
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Viewing PDF Guides on Screen
While reading the PDF version of a guide onscreen:
Â Show bookmarks to see the guide�s outline, and click a bookmark to jump to the 

corresponding section.
Â Search for a word or phrase to see a list of places where it appears in the document. 

Click a listed place to see the page where it occurs. 
Â Click a cross-reference to jump to the referenced section. Click a web link to visit the 

website in your browser.

Printing PDF Guides
If you want to print a guide, you can take these steps to save paper and ink:
Â Save ink or toner by not printing the cover page.
Â Save color ink on a color printer by looking in the panes of the Print dialog for an 

option to print in grays or black and white.
Â Reduce the bulk of the printed document and save paper by printing more than one 

page per sheet of paper. In the Print dialog, change Scale to 115% (155% for Getting 
Started). Then choose Layout from the untitled pop-up menu. If your printer supports 
two-sided (duplex) printing, select one of the Two-Sided options. Otherwise, choose 
2 from the Pages per Sheet pop-up menu, and optionally choose Single Hairline from 
the Border menu. (If you�re using Mac OS X v10.4 Tiger or earlier, the Scale setting is 
in the Page Setup dialog and the Layout settings are in the Print dialog.)

You may want to enlarge the printed pages even if you don�t print double sided, because 
the PDF page size is smaller than standard printer paper. In the Print dialog or Page Setup 
dialog, try changing Scale to 115% (155% for Getting Started, which has CD-size pages).

Getting Documentation Updates
Periodically, Apple posts revised help pages and new editions of guides. Some revised 
help pages update the latest editions of the guides.
Â To view new onscreen help topics for a server application, make sure your server or 

administrator computer is connected to the Internet and click �Latest help topics� or 
�Staying current� in the main help page for the application.

Â To download the latest guides in PDF format, go to the Mac OS X Server 
documentation website:
www.apple.com/server/documentation

Â An RSS feed listing the latest updates to Mac OS X Server documentation and 
onscreen help is available. To view the feed use an RSS reader application, such as 
Safari or Mail:
feed://helposx.apple.com/rss/leopard/serverdocupdates.xml

http://www.apple.com/server/documentation/
feed://helposx.apple.com/rss/leopard/serverdocupdates.xml
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Getting Additional Information
For more information, consult these resources:
Â Read Me documents�important updates and special information. Look for them on 

the server discs.
Â Mac OS X Server website (www.apple.com/server/macosx)�gateway to extensive 

product and technology information.
Â Mac OS X Server Support website (www.apple.com/support/macosxserver)�access to 

hundreds of articles from Apple�s support organization.
Â Apple Training website (www.apple.com/training)�instructor-led and self-paced 

courses for honing your server administration skills.
Â Apple Discussions website (discussions.apple.com)�a way to share questions, 

knowledge, and advice with other administrators.
Â Apple Mailing Lists website (www.lists.apple.com)�subscribe to mailing lists so you 

can communicate with other administrators using email.
Â Apple Product Security Mailing Lists website (lists.apple.com/mailman/listinfo/security-

announce/)�Mailing lists for communicating by email with other administrators 
about security notifications and announcements.

Â Open Source website (developer.apple.com/darwin/)�Access to Darwin open source 
code, developer information, and FAQs.

Â Apple Product Security website (www.apple.com/support/security/)�Access to 
security information and resources, including security updates and notifications.

For additional security-specific information, consult these resources:
Â NSA security configuration guides (www.nsa.gov/snac/)�The National Security 

Agency (NSA) provides information about securely configuring proprietary and open 
source software.

Â NIST Security Configuration Checklists Repository (checklists.nist.gov/repository/
category.html)�This is the National Institute of Standards and Technology (NIST) 
repository for security configuration checklists.

Â DISA Security Technical Implementation Guide (www.disa.mil/gs/dsn/policies.html)�
This is the Defense Information Systems Agency (DISA) guide for implementing 
secure government networks. A Department of Defense (DoD) PKI Certificate is 
required to access this information.

Â CIS Benchmark and Scoring Tool (www.cisecurity.org/bench_osx.html)�This is the 
Center for Internet Security (CIS) benchmark and scoring tool used to establish CIS 
benchmarks.
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1 Introduction to Leopard Server 
Security Architecture

Use this chapter to learn about the features in Leopard Server 
that can enhance security on your computer

Security has never been a more important consideration when selecting a computer 
platform. Whether you�re a home user with a broadband Internet connection, 
a professional with a mobile computer, or an IT manager with thousands of 
networked systems, you need to safeguard the confidentiality of information and 
the integrity of your computers.

With Leopard Server, a security strategy is implemented that is central to the 
design of the operating system are designed to enhance security on your computer, 
Leopard Server provides the following features.
Â Modern security architecture. Leopard includes state-of-the-art, standards-based 

technologies that enable Apple and third-party developers to build secure software 
for the Mac. These technologies support all aspects of system, data, and networking 
security required by today�s applications. 

Â Secure default settings. When you take your Mac out of the box, it is securely 
configured to meet the needs of most common environments, so you don�t need to 
be a security expert to set up your computer. The default settings are designed to 
make it very difficult for malicious software to infect your computer. You can further 
configure security on the computer to meet organizational or user requirements.

Â Innovative security applications. Leopard includes features that take the worry out 
of using a computer. For example, FileVault protects your documents by using strong 
encryption, an integrated VPN client gives you secure access to networks over the 
Internet, and a powerful firewall secures your home network. 

Â Open source foundation. Open source methodology makes Leopard a robust, 
secure operating system, because its core components have been subjected to peer 
review for decades. Problems can be quickly identified and fixed by Apple and the 
larger open source community.
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Â Rapid response. Because the security of your computer is important, Apple responds 
rapidly to provide patches and updates. Apple works with worldwide partners, 
including the Computer Emergency Response Team (CERT), to notify users of 
potential threats. If vulnerabilities are discovered, the built-in Software Update tool 
notifies users of security updates, which are available for easy retrieval and 
installation. 

Security Architectural Overview
Leopard Server security services are built on two open source standards: 
Â Berkeley Software Distribution (BSD). BSD is a form of UNIX that provides 

fundamental services, including the Leopard Server file system and file access 
permissions. 

Â Common Data Security Architecture (CDSA). CDSA provides a wide array of security 
services, including more specific access permissions, authentication of user identities, 
encryption, and secure data storage.

UNIX Infrastructure
The Leopard Server kernel�the heart of the operating system�is built from BSD 
and Mach.

Among other things, BSD provides basic file system and networking services and 
implements a user and group identification scheme. BSD enforces access restrictions to 
files and system resources based on user and group IDs. 

Mach provides memory management, thread control, hardware abstraction, and 
interprocess communication. Mach enforces access by controlling which tasks can 
send a message to a Mach port. (A Mach port represents a task or some other 
resource.) BSD security policies and Mach access permissions constitute an essential 
part of security in Leopard Server, and are both critical to enforcing local security.

Access Permissions
An important aspect of computer security is the granting or denying of access 
permissions (sometimes called access rights). A permission is the ability to perform 
a specific operation, such as gaining access to data or to execute code. 

Permissions are granted at the level of folders, subfolders, files, or applications. 
Permissions are also granted for specific data in files or for application functions.

Permissions in Leopard Server are controlled at many levels, from the Mach and 
BSD components of the kernel through higher levels of the operating system, 
and�for networked applications�through network protocols.
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Security Framework
The security framework in Leopard is an implementation of the CDSA architecture. 
It contains an expandable set of cryptographic algorithms to perform code signing 
and encryption operations while maintaining the security of the cryptographic keys. 
It also contains libraries that allow the interpretation of X.509 certificates. 

The CDSA code is used by Leopard features such as Keychain and URL Access for 
protection of login data.

Apple built the foundation of Leopard and many of its integrated services with open 
source software�such as FreeBSD, Apache, and Kerberos, among others�that has 
been made secure through years of public scrutiny by developers and security experts 
around the world. 

Strong security is a benefit of open source software because anyone can inspect the 
source code, identify theoretical vulnerabilities, and take steps to strengthen the 
software. 

Apple actively participates with the open source community by routinely releasing 
updates of Leopard Server that are subject to independent developers� ongoing 
review�and by incorporating improvements. An open source software development 
approach provides the transparency necessary to ensure that Leopard Server is truly 
secure.

Layered Security Defense
Leopard Server security is built on a layered defense for maximum protection. Security 
features such as the following provide solutions for securing data at all levels, from the 
operating system and applications to networks and the Internet.

Â Secure worldwide communication�Firewall and mail filtering help prevent 
malicious software from compromising your computer.

Secure Worldwide Communication Internet

Secure Applications

Secure Network Protocols

Security Services

Secure Boot/”Lock Down”

Applications

Network

Operating System

Hardware
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Â Secure applications�FileVault (an application of encrypted disk images) helps 
prevent intruders from using your applications and viewing data on your computer.

Â Secure network protocols�Secure Sockets Layer (SSL) is a protocol that helps 
prevent intruders from viewing information exchange across a network, and 
Kerberos secures the authentication process.

Â Security Services�Authentication using keychains, together with POSIX and ACL 
permissions, helps prevent intruders from using your applications and accessing your 
files.

Â Secure hardware�The Firmware Password Utility helps prevent people who can 
access your hardware from gaining root-level access permissions to your computer 
files.

Credential Management
A keychain is used to store passwords, keys, certificates, and other data placed in the 
keychain by a user. Due to the sensitive nature of this information, keychains use 
cryptography to encrypt and decrypt secrets, and they safely store secrets and related 
data in files.

Leopard Server Keychain services enable you to create keychains and securely store 
keychain items. After a keychain is created, you can add, delete, and edit keychain 
items, such as passwords, keys, certificates, and notes for users. 

A user can unlock a keychain through authentication (by using a password, digital 
token, smart card) and applications can then use that keychain to store and retrieve 
data, such as passwords.

Network Security
The default security settings on your Leopard Server computer are configured to be 
secure from local network and Internet attacks.

Secure Transport is used to implement SSL and Transport Layer Security (TLS) protocols. 
These protocols provide secure communications over a TCP/IP connection such as the 
Internet by using encryption and certificate exchange.

Public Key Infrastructure (PKI)
Certificate, key, and trust services include functions to:
Â Create, manage, and read certificates
Â Add certificates to a keychain
Â Create encryption keys
Â Manage trust policies

These functions are used when the services call Common Security Service Manager 
(CSSM) functions. This is transparent to users.
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Authorization Versus Authentication
Authorization is the process by which an entity, such as a user or a computer, 
demonstrates that they are who they say they are and as a result obtains the right to 
perform a restricted operation. 

For example, the user, entering a password which only he or she could know, allows 
the system to authenticate that user.

Authorization can also refer to the right itself, as in �Anne has the authorization to run 
that program.� Authorization usually involves authenticating the entity and then 
determining whether it has the correct permissions.

Authentication is normally done as a step in the authorization process. Some 
applications and operating system components carry out their own authentication. 
Authentication might use authorization services when necessary.

Security Features in Leopard Server
Leopard Server includes the following new security features and technologies to 
enhance the protection of your computer and your personal information.
Â Tagging and first-run warning:  Leopard Server marks files that are downloaded to 

help prevent users from inadvertently running malicious downloaded applications.
Â Runtime Protection:  New technologies such as execute disable, library 

randomization, and sandboxing help prevent attacks that try to hijack or modify the 
software on your system.

Â Improved Firewall:  After you activate the new application firewall, the firewall 
configures itself to restrict incoming applications for users without requiring the user 
to write complicated rules.

Â Mandatory access control:  These enforce restrictions on access to system resources.
Â Application signing:  This enables you to verify the integrity and identity of 

applications on your Mac.

Mandatory Access Controls
Leopard Server introduces a new access control mechanism known as mandatory 
access controls. Although the Mandatory Access Control technology is not visible to 
users, it is included in Leopard Server to protect your computer.

Mandatory access controls are policies that cannot be overridden. These policies set 
security restrictions created by the developer. This approach is different from 
discretionary access controls that permit users to override security policies according to 
their preferences.
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Mandatory access controls in Leopard Server aren�t directly visible to users, but they 
are the underlying technology that helps enable several important new features, 
including sandboxing, parental controls, managed preferences, and a safety net feature 
for Time Machine.

The Time Machine feature illustrates the difference between mandatory access controls 
and the user privilege model�it allows files within Time Machine backups to be 
deleted only by programs related to Time Machine. 

From the command line, no user�not even one logged in as root�can delete files 
in a Time Machine backup. Time Machine uses this strict policy because it uses new 
file system features in Leopard Server. The policy prevents corruption in the backup 
directory by preventing tools from deleting files from backups, because some tools 
may not recognize the new file system features.

Mandatory access controls are integrated with the exec system service to prevent the 
execution of unauthorized applications. This is the basis for application controls in 
parental controls in Leopard and managed preferences in Leopard Server.

Mandatory access controls enable strong parental controls. In the case of the new 
sandboxing facility, mandatory access controls restrict access to system resources as 
determined by a special sandboxing profile that is provided for each sandboxed 
application. This means that even processes running as root can have extremely limited 
access to system resources.

Sandboxing
Sandboxing helps ensure that applications do only what they�re intended to do by 
placing controls on applications that restrict what files they can access, whether the 
applications can communicate over the network, and whether the applications can be 
used to launch other applications. 

In Leopard Server, many of the system�s helper applications that normally communicate 
with the network�such as mDNSResponder (the software underlying Bonjour) and the 
Kerberos KDC�are sandboxed to guard them from abuse by attackers trying to access 
the system. 

In addition, other programs that routinely take untrusted input (for instance, arbitrary 
files or network connections) such as Xgrid and the Quick Look and Spotlight 
background daemons are sandboxed. 

Sandboxing is based on the system�s mandatory access controls mechanism, which is 
implemented at the kernel level. Sandboxing profiles are developed for each 
application that runs in a sandbox, describing precisely which resources are accessible 
to the application.
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Managed Preferences
Managed Preferences provide computer administrators with tools to enforce policy. 
Administrator users can use features like Simple Finder to limit the launching of a set 
of applications or they can create a whitelist of web sites that users can visit. This is 
the kind of simple interface that administrators of a public library or computer 
environment can use to restrict access to applications or sites to keep users from 
performing malicious activities.

In Leopard Server, you use Workgroup Manager to manage preferences for users of 
Leopard systems.

Quarantine Applications
Applications that download files from the Internet or receive files from external sources 
(such as mail attachments) can use the Quarantine feature to provide a first line of 
defense against malicious software such as Trojan horses. When an application receives 
an unknown file, it adds metadata (quarantine attributes) to the file using new 
functions found in Launch Services.

Files downloaded using Safari, Mail, and iChat are tagged with metadata indicating that 
they are downloaded files and refer to the URL, date, and time of the download. This 
metadata is propagated from archives that are downloaded (such as ZIP or DMG files) 
so that any file extracted from the archive is also tagged with the same information. 
This metadata is used by the download inspector to prevent dangerous file types from 
being opened unexpectedly.

The first time you try to run an application that has been downloaded, download 
inspector inspects the file, asks whether you want to run the application, and displays 
the information on the date, time, and location of the download. 

You can continue to open the application or cancel the attempt, which is appropriate 
if you don�t recognize or trust the application. After an application is opened, this 
message does not appear again for that application and the quarantine attributes 
are lifted. 

This new mechanism dramatically reduces the number of warnings related to 
downloads that you see. Such messages now appear only when you attempt to launch 
a downloaded application. When you do see a warning, you are given useful 
information about the source of the download that can help you make an informed 
decision about whether to proceed. 

Application-Based Firewall
A new application-based firewall makes it easier for nonexperts to get the benefits of 
firewall protection. The new firewall allows or blocks incoming connections on a per-
application basis, rather than on a per-port basis.
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Users can restrict firewall access to essential network services (such as those needed for 
DHCP, BOOTP, IPSec VPNs, and Bonjour), or they can allow (or block) access to selected 
applications on an individual basis. The application firewall uses digital signatures to 
verify the identity of applications. If you select an unsigned application, Leopard Server 
signs that application to uniquely identify it.

For expert users, the IPFW firewall is still available on the system. Because IPFW 
handles packets at the protocol-layer of the networking stack and the application 
firewall is a application layer filter, the IPFW rules take precedence.

Signed Applications
By signing applications, your Mac can verify the identity and integrity of an application. 
All applications shipped with Leopard Server are signed by Apple. In addition, 
third-party software developers can sign their software for the Mac. Application signing 
doesn�t provide intrinsic protection, but it integrates with several other features to 
enhance security.

Features�such as parental controls, managed preferences, Keychain, and the 
firewall�use application signing to verify that the applications they are working with 
are the correct, unmodified versions. 

With Keychain, the use of signing dramatically reduces the number of Keychain dialogs 
presented to users because the system can validate the integrity of an application that 
uses the Keychain. With parental controls and managed preferences, the system uses 
signatures to verify that an application runs unmodified.

The application firewall uses signatures to identify and verify the integrity of 
applications that are granted network access. In the case of parental controls and the 
firewall, unsigned applications are signed by the system on an ad hoc basis to identify 
them and verify that they remain unmodified.

Smart Card Unlock of FileVault and Encrypted Storage
Smart cards enable you to carry your digital certificates with you. With Leopard, you 
can use your smart card whenever an authentication dialog is presented.

Leopard Server has the following four token modules to support this robust, two-factor 
authentication mechanism and Java Card 2.1 standards:

Â Belgium National Identification Card (BELPIC)
Â Department of Defense Common Access Card (CAC)
Â Japanese government PKI (JPKI)
Â U.S. Federal Government �Personal Identity Verification also called FIPS-201(PIV)
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Other commercial Smart Card vendors provide token modules to support integrations 
of their Smart Card with the Mac OS X Smart Card architecture.

Similar to an ATM card and a PIN code, two-factor authentication relies on something 
you have and something you know. If your smart card is lost or stolen, it cannot be 
used unless your PIN is also known. 

Leopard has additional functionality for smart card use, such as:

Â Lock system on smart card removal. You can configure your Mac to lock the system 
when you remove your smart card.

Â Unlock keychain. When you insert a smart card, the keychain can be unlocked, and 
your stored information and credentials can be used.

Â Unlock FileVault. You can use smart card to unlock your FileVault encrypted home 
directory. You can enable this function by using a private key on a smart card.

Sharing and Collaboration Services
In Leopard Server, you can enable and configure sharing services to allow access only 
to users that you specify through access control lists (ACLs). You can create user 
accounts for sharing based on existing user accounts on the system, and for entries in 
your address book. Sharing services become more secure with ACLs.

Enhanced Encrypted Disk Image Cryptography
The Disk Utility tool included in Leopard enables you to create encrypted disk 
images�using 128-bit (default) or even stronger 256-bit AES encryption�so you 
can safely mail valuable documents, files, and folders to friends and colleagues, 
save the encrypted disk image to CD or DVD, or store it on the local system or 
a network file server. FileVault also uses this same encrypted disk image technology 
to protect user folders.

A disk image is a file that appears as a volume on your hard drive. It can be copied, 
moved, or opened. When the disk image is encrypted, files or folders placed in it are 
encrypted. 

To see the contents of the disk image, including metadata such as file name, date, size, 
or other properties, a user must enter the password or have a keychain with the correct 
password. 

The file is decrypted in real time, only as the application needs it. For example, if you 
open a QuickTime movie from an encrypted disk image, Leopard decrypts only the 
portion of the movie currently playing. 
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Enhanced VPN Compatibility and Integration
Leopard Server includes a universal VPN client with support built into the Network 
preferences pane, so you have everything you need to establish a secure connection. 
The VPN client supports L2TP over IPSec and PPTP, which makes Apple�s VPN client 
compatible with the most popular VPN servers, including those from Microsoft and 
Cisco.

You can also use digital certificates and one-time password tokens from RSA or 
CryptoCARD for authentication in conjunction with the VPN client. The one-time 
password tokens provide a randomly generated passcode number that must be 
entered with the VPN password�a great option for those who require extremely 
robust security. 

In addition, the L2TP VPN client can be authenticated using credentials from a Kerberos 
server. In either case, you can save the settings for each VPN server you routinely use as 
a location, so you can reconnect without needing to reconfigure your system each 
time.

Apple�s L2TP VPN client can connect you to protected networks automatically by using 
its VPN on demand feature. VPN on demand can detect when you want to access a 
network that is protected by a VPN server and can start the connection process for you. 
This means that your security is increased because VPN connections can be closed 
when not in use, and you can work more efficiently.

In Leopard Server, the VPN client includes support for Cisco Group Filtering and DHCP 
over PPP to dynamically acquire additional configuration options such as static routes 
and search domains. 

Improved Secure Connectivity
VPN support has been enhanced to connect to more of the most popular VPN 
servers�without additional software.
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2 Installing Leopard Server

Use this chapter to customize the default installation of 
Leopard Server for your specific network security needs.

By securely configuring the different stages of the installation process and 
understanding Leopard Server permissions, you can make sure that your computer 
is hardened to match your security policy.

Important:  When possible, computers should remain isolated from the operational 
network until they are completely and securely configured. Use an isolated test 
network for installation and configuration. 

System Installation Overview
Although a secure configuration of an existing Leopard Server installation is possible, 
securely configuring a fresh installation is simpler. This might not always be practical, 
but it is the recommended way to configure Leopard Server. 

The preinstallation of Leopard Server on a new computer is not locked down from 
a security standpoint. This is by design, because a server is used to administer an entire 
network and typically needs additional services. If a previous installation of 
Leopard Server exists on a computer, consider a clean installation of Leopard Server by 
doing an Erase and Install or by reformatting the volume.

When you configure your new partitions, you should securely erase the partition that 
you�re installing Leopard Server on. For more information, see �Securely Erasing Data� 
on page 169.

WARNING:  The Erase and Install option completely erases the content of a volume. 
Be sure to back up your files before continuing.
When backing up and restoring information, use the following guidelines:

Â Back up only user files and data. Restoring system settings might change the 
system configuration.

Â Reinstall applications from the original media. Do not restore them from a backup.
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If you decide against securely erasing the partition, securely erase free space after 
installing Leopard Server. For more information, see �Using Disk Utility to Securely Erase 
a Disk or Partition� on page 170.

There are several ways to install the operating system, depending on your environment 
and installation strategy. These include:
Â Installing locally from DVD
Â Installing locally from another partition or disk
Â Installing remotely from an administrator computer

Disabling the Firmware Password
Before installing Leopard, disable the Open Firmware password (for PowerPC-based 
computers) or the Extensible Firmware Interface (EFI) password (for Intel-based 
computers).

Disabling the Firmware Password (PPC-Based Computers)
If Leopard is already installed, use the Firmware Password Utility to disable the firmware 
password. 

To disable the Open Firmware password:
1 Restart the computer while holding down the Command, Option, O, and F keys.

2 When prompted, enter the Open Firmware password.

If you are not prompted to enter a password, the Open Firmware password is disabled.

3 Enter the following commands:

reset-nvram

reset-all

Disabling the Firmware Password (Intel-Based Computers)
If you are using an Intel-based Macintosh computer use the Firmware Password Utility 
to disable the EFI password.

For more information about the Firmware Password Utility, see �Using the Firmware 
Password Utility� on page 87.

Preparing an Administrator Computer 
You can use an administrator computer to install, set up, and administer Leopard Server 
on another computer. An administrator computer is a computer with Leopard or 
Leopard Server that you use to manage remote servers.

When you install and set up Leopard Server on a computer that has a display and 
keyboard, it�s already an administrator computer. To make a computer with Leopard 
into an administrator computer, you must install additional software.
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Important:  If you have administrative applications and tools from Mac OS X Server 
version 10.4 Tiger or earlier, do not use them with Leopard.

To enable remote administration of Leopard Server from a Leopard computer: 
1 Make sure the computer has Leopard installed. 

2 Make sure the computer has at least 1 GB of RAM and 1 GB of unused disk space. 

3 Insert the Administration Tools CD. 

4 Open the Installers folder. 

5 Open ServerAdministrationSoftware.mpkg to start the Installer, and then follow the 
onscreen instructions. 

The Server Installation Disc
You can install the server software using the Mac OS X Server Install Disc. This 
installation disc contains everything you need to install Leopard Server. It also contains 
an Other Installs folder, which has installers for upgrading a Leopard computer to 
Leopard Server and for separately installing server administration software, the 
Directory application, the Podcast Capture application, X11 software, and Xcode 
developer tools. 

In addition to the installation disc, Leopard Server includes the Administration Tools CD. 
You use this disc to set up an administrator computer. This disc also contains installers 
for the Directory application, the Podcast Capture application, and the QuickTime 
Streaming Server (QTSS) Publisher application. For advanced administrators, this disc 
contains installers for PackageMaker and Property List Editor.

Setting Up Network Services
Before you can install, you must set up or have the following settings for your network 
service:
Â Domain Name System (DNS):  You must have a fully qualified domain name for each 

server�s IP address in DNS. The DNS zone must have the reverse-lookup record for the 
name and address pair. Not having a stable, functioning DNS system with reverse 
lookup leads to service failures and unexpected behaviors.
The standalone server setup choice in the assistant will set up a local DNS server and 
configure the server to look at 127.0.0.1 for DNS. This zone will not recurse to any 
other server setup and will assume that it is authoritative for the zone entered during 
setup. 

Â Dynamic Host Configuration Protocol (DHCP):  Avoid assigning dynamic IP 
addresses to servers. If your server gets its IP address through DHCP, set up a static 
mapping in the DHCP server, so your server gets the same IP address every time 
(via its Ethernet address).
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Â Firewall or routing:  In addition to any firewall running on your server, the subnet 
router might have network traffic restrictions in place. Make sure your server�s IP 
address is available for the traffic you are planning to handle and the services you 
are planning to run.

Connecting to the Directory During Installation
If you want to use a server as an Open Directory master, make sure it has an active 
Ethernet connection to a secure network before installation and initial setup.

Installing Server Software on a Networked Computer
When you start up a computer from a server installation disc, SSH starts so that remote 
installations can be performed.

Important:  Before you install or reinstall Leopard Server, make sure the network is 
secure. Secure Shell (SSH) gives others access to the computer over the network. 
For example, design the network topology so you can make the server computer�s 
subnet accessible only to trusted users.

Starting Up for Installation
The computer can�t install to its own startup volume, so you must start up in some 
other way, such as:
Â Optical Media, DVDs
Â Alternate volumes (second partitions on the hard disk or external FireWire disks)
Â Netboot

The computer must install from the same disk or image that started up the computer. 
Mounting another share point with an installer won�t work. The installer uses some of 
the files currently active in the booted system partition for the new installation.

Before Starting Up
If you�re performing a clean installation rather than upgrading an existing server, back 
up user data on the disk or partition where you�re installing the server software to an 
encrypted storage device or to storage media stored in a secured area.

If you�re upgrading an existing server, make sure that saved setup data won�t be 
inadvertently detected and used to automatically set up an advanced configuration. 
Server Assistant looks for saved setup data on all mounted disks and in all directories 
the server is configured to access. The saved setup data overwrites the server�s existing 
settings.
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Remotely Accessing the Install DVD
When used as the startup disc, the Install DVD provides some services for remote 
access. After you start up from the DVD, SSH and Virtual Network Computing (VNC) 
are available for use. 

VNC enables you to use a VNC viewer (like Apple Remote Desktop) to view the user 
interface as if you were using the remote computer�s keyboard, mouse, and monitor. 
All the things you could do at the computer using the keyboard and mouse are 
available remotely, as well as locally. This excludes hard resets, other hardware 
manipulation, or holding down keys during startup.

SSH enables you to have command-line access to the computer, with administrator 
privileges.

Important:  To securely and remotely install Leopard Server, perform the installation in 
a trusted environment. 

To access the computer with VNC:
1 Start the target server from the Install DVD for Leopard Server or later. 

The procedure you use depends on the target server hardware.

To learn more about startup disk options, see �Starting Up for Installation� on page 39.

2 Establish an SSH tunnel between the local host and the remote server to securely 
perform the installation by redirecting the VNC traffic through the tunnel.

For example, to redirect Apple Remote Desktop traffic through an SSH tunnel, enter:

ssh -v -L 2501:local_host:5900 target_server -l target_server_username

3 Use your VNC viewer software to open a connection to the target server.

4 Identify the target server.

If the VNC viewer includes the target server in a list of available servers, select it in the 
list. Otherwise, enter an IP address in IPv4 format (000.000.000.000).

If you don�t know the IP address and the remote server is on the local subnet, use the 
sa_srchr command to identify computers on the local subnet where you can install 
server software. Enter the following from an existing computer with Mac OS X Server 
Tools installed:

/System/Library/Serversetup/sa_srchr 224.0.0.1

This command returns the IP address and the EthernetID (in addition to other 
information) of servers on the local subnet that started up from the installation disk.
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5 When prompted for a password, enter the first eight digits of the server�s built-in 
hardware serial number.

To find a server�s serial number, look for a label on the server.

If you�re installing on an older computer that has no built-in hardware serial number, 
use 12345678 for the password.

If you�re using Apple Remote Desktop as a VNC viewer, enter the password but don�t 
specify a user name.

Important:  This password is valid only during setup.

To access the computer with SSH:
1 Start the target computer from the Install DVD for Leopard Server or later. 

The procedure you use depends on the target server hardware.

To learn more about startup disk options, see �Starting Up for Installation� on page 39.

2 Use the Terminal to open an SSH connection to the target server.

The user name is root and the password is the first eight digits of the server�s built-in 
hardware serial number.

To find a server�s serial number, look for a label on the server. If you�re installing on an 
older computer that has no built-in hardware serial number, use 12345678 for the 
password.

Important:  This password is valid only during setup.

If you don�t know the IP address and the remote server is on the local subnet, you can 
use the sa_srchr command to identify computers on the local subnet where you can 
install server software. Enter the following from an existing computer with Mac OS X 
Server Tools installed:

/System/Library/Serversetup/sa_srchr 224.0.0.1

This command returns the IP address and EthernetID (in addition to other information) 
of servers on the local subnet that started up from the installation disk.

Starting Up from the Install DVD
The easiest and most secure way to install Leopard Server is to install it physically at the 
computer, known as a local installation, using the DVD. When performing a local 
installation, it is recommended, if applicable, that the entire drive be reformatted using 
at least a 7-pass secure erase, rather than only reformatting the partition where 
Leopard Server is to be installed, in case sensitive information was left on the other 
partitions.

If the target server is an Xserve with a built-in DVD drive, start the server using the 
Install DVD by following the instructions in the Xserve User�s Guide for starting from a 
system disc.
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If the target server has no built-in DVD drive, you can use an external FireWire DVD 
drive. You can also install server software on an Xserve system that lacks a DVD drive by 
moving its drive module to another Xserve system that has a DVD drive.

If your server has multiple partitions and you are only installing on a partition, you 
should still perform a secure erase of that partition. This type of installation is known as 
a clean installation. After the drive is securely erased and formatted, partitions can be 
created as required. 

When installing the Leopard Server, only install the packages that are needed. All data 
on the target drive is lost during the installation.

To start up the computer with the installation disc:
1 Turn on the computer and insert the Leopard Server installation disc into the DVD 

drive.

2 If you�re using a built-in DVD drive, restart the computer while holding down the C key. 

You can release the C key when you see the Apple logo. 

Alternatively, restart the computer by holding down the Option key, selecting the icon 
representing the installation disc, and then clicking the right arrow.

You must use this method if you are starting up from an external DVD drive.

If you�re installing on an Xserve, see the User�s Guide or Quick Start that came with your 
Xserve and follow the instructions to start up the installation.

3 After the computer restarts, choose the language you want to use during installation 
and then click the arrow button. 

The Installer is now running.

4 When the Installer opens, choose Utilities > Open Disk Utility to securely erase the 
target disk before proceeding. 

To securely erase and format the disk or partition, use Disk Utility. For more 
information, see �Using Disk Utility to Securely Erase a Disk or Partition� on page 170.

Starting Up from an Alternate Partition
For a single-server installation, preparing to start up from an alternate partition can be 
more time-consuming than using the Install DVD. The time required to image, scan, 
and restore the image to a startup partition can exceed the time taken to install once 
from the DVD. 

WARNING:  The following instructions cause all information about the target volume 
(disk or partition) to be lost. Back up any data on the volume that should be retained.



Chapter 2    Installing Leopard Server 43

 

However, if you are reinstalling regularly, or if you are creating an external Firewire 
drive-based installation to take to various computers, or if you need some other kind 
of mass distribution (such as clustered Xserves without DVD drives installed), this 
method can be very efficient.

Note:  When creating a bootable external disk, you can use the Apple Partition Map 
(APM) format with Leopard Server to create a universal boot disk that will function 
on PowerPC and Intel hardware. The Leopard Server installer DVD is an APM disk. 
However, strictly speaking, only the GUID Partitioning format is supported on 
Intel-based Macs and only APM is supported on Power-PC Macs.

This method is suited to installing on computers that you might not have easy physical 
access to. With sufficient preparation, this method can be modified for easy mass 
deployment of licensed copies of Leopard Server.

To use this method, you must have an existing installation on the computer. It is 
intended for environments where a level of existing infrastructure of Leopard Server 
is present, and might be unsuitable for a first-server installation. 

To start from an alternate partition, there are four basic steps.

Step 1:  Prepare the disks and partitions on the target computer
Before you proceed, you must have at least two partitions on the target computer. The 
first is going to be the initial and the final startup partition. 

The second is the temporary installer partition. You can use a single disk with multiple 
partitions, or you can use multiple disks. You use Disk Utility to prepare the disks.

For more information about preparing and partitioning a hard disk, see the Disk Utility 
help.

Step 2:  Create a restorable image of the Install DVD
This step doesn�t need to be performed on the target computer. It can be done on an 
administrator computer, but there must be enough free space to image the entire 
Install DVD.

To create an image of the Install DVD:
1 Insert the Install DVD.

2 Launch Disk Utility.
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3 Select the first session icon under the optical drive icon.

This is in the list of devices on the left side of the window.

4 Select File > New > Disk Image from <device>.

Note:  Consider creating a disk image from a folder because it is more efficient. For 
more information, see the asr man page.

5 Give the image a name, select Read-only, Read/Write, or Compressed as the image 
type, and then click Save.

6 After the image is complete, select the image from list on the left.

7 In the menu, select Images > Scan Images for Restore.

8 Provide an administrator login and password as needed.

The installer disk image can now be restored to your extra partition.

From the Command Line
To use the command line, use hdiutil to create the disk image, and asr to scan the 
image for restore. All commands must be done with super-user or root privileges.
For example, this command creates a disk image �Installer.dmg� from the device at 
disk1s1:

sudo hdiutil create -srcdevice disk1s1 Installer.dmg

This command scans the image �Installer.dmg� and readies it for restore:

sudo asr imagescan --source Installer.dmg

Step 3:  Restore the image to the alternate partition
You can restore the disk image to a partition of the computer or to an external hard 
disk. When complete, the restored partition functions like the Install DVD. Make sure 
the alternate partition is at least the size of the disk image.

Restoring the disk image to the partition erases existing data on the partition.

To restore the image:
1 Start up the target computer.

2 Make sure the image does not reside on the partition that is to be erased.

3 Launch Disk Utility.

4 In the list of devices on the left side of the window, select the installer DVD image.

5 Click Restore.

6 From the left side of the window drag the installer image to the Source field.

7 From the list of devices on the left side of the window drag the alternate partition to 
the Destination field.

8 Select Erase Destination.
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9 Unmount both volumes to perform a block-level restore.

If you don�t unmount both volumes, asr, which does the copying, falls back to the 
slower file-copy mode.

10 Click Restore.

From the Command Line
If you prefer to use the command-line, you use the asr tool to restore the image to the 
partition. Using asr requires the use of superuser or root privileges. The basic syntax is:

sudo asr restore -s <compressedimage> -t <targetvol> --erase

For example, restoring an image called �Installer.dmg� to the partition �ExtraHD� 
would be:

asr restore -s Installer.dmg -t ExtraHD --erase

For more information about asr and its capabilities, see the tool�s man page.

You can use asr to restore a disk over a trusted network, multicasting the blocks to 
client computers. Using the multicast server feature of asr, you could put a copy of the 
installer image on a partition of all computers that can receive the multicast packets. 
To successfully configure this, you�ll need the information in the tool�s man page.

The asr tool can also fetch the target image from an HTTP server using http or https 
URLs as its source, so the image doesn�t need to reside on the target computer. 
However, there is a 2 GB file size limit. Also, if you use an older web server such as 
Apache 1.3, you must segment the image. 

Step 4:  Select the alternate partition as the startup disk
After the partition is restored, you can use it as a startup and installer disk for your 
server. Start up the computer from that partition. After the computer is up and 
running, it is a Leopard Server installer, exactly as if you had started the computer from 
the DVD.

To start up the computer with the installation disc:
1 Turn on the computer and hold down the Option key.

2 Select the icon representing the installation partition and then click the right arrow.

You must use this method if you are starting up from an external DVD drive.

If you�re installing on an Xserve, the procedure for starting up from a DVD might be 
different. For more information, see the Xserve User�s Guide or Quick Start that came with 
your Xserve. 

3 After the computer restarts, choose the language you want to use during installation, 
and click the arrow button. 

The Installer is now running.
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From the Command Line
If you prefer to do this at the command-line, you can set the startup volume using 
the systemsetup tool. In versions of Tiger Server or later, the systemsetup tool is at 
/usr/sbin/systemsetup.

If you are using the Leopard client during this process, the tool is at /System/Library/
CoreServices/RemoteManagement/ARDAgent.app/Contents/Support/systemsetup.

You�ll need to use the -liststartupdisks, and -setstartupdisk command options to 
find the newly restored installer volume, and select it as the startup disk. All commands 
issued with systemsetup must be run with superuser or root privileges.

The following is an example command to select the startup disk:

systemsetup -setstartupdisk “/Volumes/Mac OS X Server Install Disk”

Then issue the sudo shutdown -r time command to restart.

For more information about systemsetup and shutdown, see Command-Line 
Administration and the tool�s man page.

Starting Up from a NetBoot Environment
If you have an existing NetBoot infrastructure, this is the easiest way to perform mass 
installation and deployment. This method can be used for clusters that have no optical 
drive or existing system software.

This method can also be used in environments where large numbers of servers must 
be deployed in an efficient manner.

This section won�t tell you how to create the NetBoot infrastructure. If you want to set 
up NetBoot and NetInstall options for your network, servers, and client computers, see 
System Imaging and Software Update Administration.

This section has instructions to create a NetInstall image from the Mac OS X Server 
Install Disk, and start a server from it. There is no need to make preparations to the 
hard disk.

Step 1:  Create a NetInstall image from the Install DVD
This step doesn�t need to be done on the target computer. It can be done on an 
administrator computer that has enough free space to image the entire Install DVD.

1 Launch System Image Utility, in /Applications/Server/.

2 Select the Install DVD on the left, and choose NetInstall image on the right.

3 Click Continue.

4 Enter a name for the image, and a description.

This information is seen by clients selecting it a startup disk.

5 Click Create and then choose a protected and safe location for the disk image.
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Upon completion, this image can be used with an existing NetBoot server to start up 
a server for installation. 

You can provide another level of protection of the disk image by generating a SHA-1 
digest of the image and store the digest in a secure place. When needed, you can use 
the digest to verify the integrity of the image. 

For more information about NetInstall images and System Image Utility, including 
customization options, see System Imaging and Software Update Administration.

Step 2:  Start up the computer from the NetBoot server on a secure network
Use one of the following methods, depending on your environment.
Â In the target computer GUI, select the NetInstall disk from the Startup Disk pane of 

the System Preferences.
Â Restart the computer, holding down the �n� key.

The first NetBoot server to respond to the computer starts up the computer with its 
default image.

Â Restart the computer, holding down the Option key.
The computer shows you available startup disks, locally on the computer and 
remotely from NetBoot and NetInstall servers. Select a disk and continue the startup.

Â Use the command line locally or remotely to specify the NetBoot server that the 
computer will start up from:
sudo bless --netboot --server bsdp://server.example.com

Preparing Disks for Installing Leopard Server
Before performing a clean installation of Leopard Server, you can partition the server 
computer�s hard disk into multiple volumes, create a RAID set, or erase the target disk 
or partition.

If you�re using an installation disc for Leopard Server or later, you can perform these 
tasks from another networked computer using VNC viewer software, such as Apple 
Remote Desktop, before beginning a clean installation.

Choosing a File System
A file system is a method for storing and organizing computer files and the data they 
contain on a storage device such as a hard disk. Leopard Server supports several kinds 
of file systems. Each file system has its own strengths. You must decide which system 
fits your organization�s needs.

WARNING:  Before partitioning a disk, creating a RAID set, or erasing a disk or partition 
on a server, preserve user data you want to save by copying it to another disk or 
partition.



48 Chapter 2    Installing Leopard Server 

 

For more information, see developer.apple.com/technotes/tn/tn1150.html.

The following systems are available for use:

The Mac OS Extended (Journaled) aka HFS+J File System
An HFS+J volume is the default file system for Leopard Server.

An HFS+J volume has an optional journal to speed recovery when mounting a volume 
that was not unmounted safely (for example, as the result of a power outage or crash). 
The journal makes it quick and easy to restore the volume structures to a consistent 
state, without scanning structures.

The journal is used only for volume structures and metadata. It does not protect the 
contents of a fork. In other words, this journal protects the integrity of the underlying 
disk structures, but not data that is corrupted due to a write failure or catastrophic 
power loss.

More information about HFS+J can be found in Apple�s Developer Documentation at:

developer.apple.com/documentation/MacOSX/Conceptual/BPFileSystem/Articles/
Comparisons.html

The Mac OS Extended (Journaled, Case-Sensitive) aka HFSX File System
HFSX is an extension to HFS Plus and allows volumes to have case-sensitive file and 
directory names. Case-sensitive names means that you can have two objects whose 
names differ only by the case of the letters, in the same directory at the same time. 
For example, you could have Bob, BOB, and bob in the same directory as uniquely 
named files.

A case-sensitive volume is supported as a boot volume format. An HFSX file system for 
Leopard Server must be specifically selected when erasing a volume and preparing for 
initial installation. HFSX is an available format for the �erase and install� option for local 
installs. HFSX is not an available format for remotely controlled installations. If you are 
planning to use NFS, use case-sensitive HFSX.

An HFSX volume can be case-sensitive or case-insensitive. Case sensitivity (or lack 
thereof ) is global to the volume. The setting applies to all file and directory names on 
the volume. 

To determine whether an HFSX volume is case sensitive, check whether it appears as 
Mac OS Extended or Mac OS X Extended (case-sensitive) in Disk Utility. Alternatively, 
run the following command to see if it creates one or two files.

$ touch aaaa AAAA

If the volume is not case sensitive, only one file (aaaa) is created in the current 
directory.

http://developer.apple.com/technotes/tn/tn1150.html
http://developer.apple.com/documentation/MacOSX/Conceptual/BPFileSystem/Articles/Comparisons.html
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Note:  An HFSX volume might not be case-sensitive. Additionally, your third-party 
software solutions might not work correctly with case sensitivity.

Important:  Case-sensitive names do not ignore Unicode ignorable characters. This 
means that a single directory can have several names that would be considered 
equivalent using Unicode comparison rules, but they are considered distinct on 
a case-sensitive HFSX volume.

Partitioning a Hard Disk
Partitioning the hard disk creates a volume for server system software and additional 
volumes for data and other software. Partitioning erases previous contents of the disk.

The minimum recommended size for an installation partition is 20 GB. A larger volume 
is recommended for a standard or workgroup configuration because they keep shared 
folders and group websites on the startup volume together with the server software. 

Erasing a disk is another way of saying that you have given a disk a single volume 
partition and erased that volume.

Consider dedicating a hard disk or a volume of a partitioned hard disk to server 
software. Put additional software, share points, websites, and so forth on other disks or 
volumes. With this approach, you can upgrade or reinstall the server software without 
affecting your other software or user data and you can improve performance by 
relieving the Input/Output connection. 

If you must store additional software or data on the system volume, consider mirroring 
it to another drive.

Note:  Having an extra, empty partition or two on the target installation disk can give 
you additional flexibility in installation and deployment. For example, additional space 
can give you a place to temporarily mirror your current installation before performing 
an in-place update, or it can give you a fast installer disk.

Partitioning a Disk Using Disk Utility
You can use the Installer to open the Disk Utility application and then use Disk Utility to 
erase the installation target volume or another volume. 

You can erase the target volume using the Mac OS Extended format, Mac OS Extended 
(Journaled) format, Mac OS Extended format (Case-Sensitive) format, and Mac OS 
Extended (Journaled, Case-Sensitive) format. 

You cannot partition the active startup disk or erase the active startup volume.

1 Launch Disk Utility.

If you are in the Installer, Disk Utility is available from the Utilities menu.

Otherwise, launch the application from /Applications/Utilities/Disk Utility.
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2 Select the disk to be partitioned.

You can�t select your current startup disk. Selecting a volume on the disk allows you to 
erase the volume but does not create a different partition scheme.

3 Click Partition.

4 Choose your partition scheme and follow the instructions in the window to set all 
necessary parameters.

5 Click Apply.

You can find instructions for partitioning the hard disk into multiple volumes, creating 
a RAID set, and erasing the target disk or partition by viewing Disk Utility Help. To view 
Disk Utility Help, open Disk Utility on another Macintosh computer with Leopard and 
choose Help > Disk Utility Help.

Partitioning a Disk Using the Command Line
You can use the diskutil command-line tool to partition and erase a hard disk. Normally, 
you would use a remote shell (SSH) to log in to the newly started computer to use this 
method. The tool to partition disks is diskutil.

In the same manner as using Disk Utility, you can erase the target volume using the 
Mac OS Extended format, Mac OS Extended (Journaled) format, Mac OS Extended 
format (Case-Sensitive) format, and Mac OS Extended (Journaled, Case-Sensitive) 
format. 

You cannot partition the active startup disk or erase the active startup volume.

All potentially destructive diskutil operations must be done with superuser or root 
privileges. 

Additional information about diskutil and other uses can be found in Command-Line 
Administration. For complete command syntax for diskutil, consult the tool�s man 
page.

The specific command issued depends on your disk format needs and the hardware in 
use. Take care to use command-line arguments that apply to your specific needs. 

The following command is a sample, which partitions a computer�s only 120 GB hard 
disk into two equal 60 GB journaled HFS+ volumes (�BootDisk� and �DataStore�), which 
can start up a PowerPC-based Macintosh computer.

The basic syntax is:

diskutil partitionDisk device numberOfPartitions APMFormat <part1Format 

part1Name part1Size> <part2Format part2Name part2Size>

So the command is:

diskutil partitionDisk disk0 2 APMFormat JournaledHFS+ BootDisk 50% 

JournaledHFS+ DataStore 50%
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Creating a RAID Set
If you�re installing Leopard Server on a computer with multiple internal hard disks, 
you can create a Redundant Array of Independent Disks (RAID) set to optimize storage 
capacity, improve performance, and increase reliability in case of a disk failure.

For example, a mirrored RAID set increases reliability by writing your data to two 
or more disks at once. If one disk fails, your server uses one of the other disks in the 
RAID set. 

You can use Disk Utility to set up a RAID set. There are two types of RAID sets and one 
additional disk option available in Disk Utility:
Â A striped RAID set (RAID 0) splits files across the disks in the set. A striped RAID set 

improves the performance of your software because it can read and write on all disks 
in the set at the same time. You might use a striped RAID set if you are working with 
large files, such as digital video. However, RAID 0 will not provide any additional 
protection for your data. The loss of one drive will result in the loss of all data.

Â A mirrored RAID set (RAID 1) duplicates files across the disks in the set. Because this 
scheme maintains two or more copies of the files, it provides a continuous backup of 
them. In addition, it can help keep data available if a disk in the set fails. Mirroring is 
recommended if you have shared files or applications that must be accessed 
frequently.
To prevent data loss, set up RAID mirroring before installing Leopard Server.

Â A concatenated disk set lets you use several disks as a single volume. This is not 
a true RAID set and offers no redundancy or performance increase.

You can combine RAID sets to combine their benefits. For example, you can create 
a RAID set that combines the fast disk access of a striped RAID set and the data 
protection of a mirrored RAID set. To do this, create two RAID sets of one type and then 
create a RAID set of another type, using the first two RAID sets as the disks. 

The RAID sets you combine must be created with Disk Utility or diskutil in Tiger or 
later.

You cannot mix the method of partitioning used on the disks in a RAID set. (The PPC 
platform is APMFormat and the Intel platform is GPTFormat.)

Mac Pro desktop computers and Intel-based Xserves can boot from a software RAID 
volume. Some Intel-based Macs do not support booting from software RAID volumes. 
If you try to start these Intel-based Macs from a software RAID volume, the computer 
might start up with a flashing question mark.

The following computers do not support booting from software RAID volumes:
Â iMac (early 2006)
Â Mac mini (early 2006) 
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No PowerPC-based Macs support booting from software RAID volumes.

If you need more sophisticated RAID support, consider a hardware RAID. It has specially 
dedicated RAID hardware and can contain over 5 terabytes of storage.

Creating a RAID Set Using Disk Utility
You can use the Installer to open Disk Utility and then use Disk Utility to create the 
RAID set from available disks. Creating a RAID set erases the contents of the disks 
involved, so it isn�t necessary to erase the disks before creating the RAID set.

RAID set volumes can be Mac OS Extended format, Mac OS Extended (Journaled) 
format, Mac OS Extended format (Case-Sensitive) format, Mac OS Extended (Journaled, 
Case-Sensitive) format, and MS-DOS FAT format. For more information about volume 
formats, see �Preparing Disks for Installing Leopard Server� on page 47.

You cannot create a RAID set from the startup disk.

To create a RAID set using Disk Utility:
1 Launch Disk Utility.

If you are in the Installer, Disk Utility is available from the Utilities menu; otherwise, 
launch the application from /Applications/Utilities/Disk Utility.

2 Select the disk to be part of the RAID set.

You can�t select your startup disk. 

When creating RAID sets or adding disks, specify the entire disk instead of a partition 
on that disk.

3 Click RAID.

4 Choose your RAID set type.

5 Drag the disks to the window.

6 Follow the instructions in the window to set parameters.

7 Click Create.

You can find instructions for partitioning the hard disk into multiple volumes, creating 
a RAID set, and erasing the target disk or partition by viewing Disk Utility Help. To view 
Disk Utility Help, open Disk Utility on another Macintosh computer with Leopard and 
choose Help > Disk Utility Help.

From the Command Line
You can use the diskutil command-line tool to create a RAID set. Normally, you would 
use a remote shell (SSH) to log in to the newly-started computer to use this method. 
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You can use diskutil to can create a RAID volume that is Mac OS Extended format, 
Mac OS Extended (Journaled) format, Mac OS Extended format (Case-Sensitive) format, 
Mac OS Extended (Journaled, Case-Sensitive) format, or MS-DOS FAT format. However 
keep in mind the following:
Â You cannot create a RAID from the startup disk.
Â When creating RAID sets or adding disks, specify the entire disk instead of a partition 

on that disk.
Â All potentially destructive diskutil operations must be done with superuser or root 

privileges.

Additional information about diskutil and other uses can be found in Command-Line 
Administration. For complete command syntax for diskutil, consult the tool�s man page.

Use command-line arguments that apply to your specific needs. The following 
command is a sample, which creates a single mirrored RAID set (RAID 1) from the first 
two disks installed in the computer (disk0 and disk1), with the resulting RAID volume 
called MirrorData.

The basic syntax is:

diskutil createRAID mirror setName format device1 device2 …

So the command is:

diskutil createRAID mirror MirrorData JournaledHFS+ disk0 disk1

Erasing a Disk or Partition
You have several options for erasing as disk, depending on your preferred tools and 
your computing environment:
Â Erasing a disk using the Installer:  You can erase a disk or partition while using the 

Mac OS X Server Installer. When you select the target volume in the Installer, you can 
also select an option to have the target disk or partition erased during installation 
using the Mac OS Extended (Journaled) format. This is the recommended format for 
a Leopard Server startup volume.

Â Erasing a disk using Disk Utility:  You can use the Installer to open Disk Utility and 
then use it to erase the target volume or another volume. You can erase the target 
volume using the Mac OS Extended format or Mac OS Extended (Journaled) format. 
You can erase other volumes using either of those formats, Mac OS Extended format 
(Case-Sensitive) format, or Mac OS Extended (Journaled, Case-Sensitive) format.
You can erase but not partition a disk or partition while using the Mac OS X Server 
Installer. When you select the target volume in the Installer, you can also select an 
option to have the target disk or partition erased during installation using the 
Mac OS Extended (Journaled) format. This is the recommended format for a Leopard 
Server startup volume.
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You can find instructions for partitioning the hard disk into multiple volumes, 
creating a RAID set, and erasing the target disk or partition by viewing Disk Utility 
Help. To view Disk Utility Help, open Disk Utility on another Macintosh computer 
with Leopard and choose Help > Disk Utility Help.

Â Erasing a disk using the command line:  You can use the command line to erase 
disks using the tool diskutil. Erasing a disk using diskutil results in losing all volume 
partitions. The command to erase a complete disk is:
diskutil eraseDisk format name [OS9Drivers | APMFormat | MBRFormat | 

GPTFormat] device

For example:

diskutil eraseDisk JournaledHFS+ MacProHD GPTFormat disk0

There is also an option to securely delete data by overwriting the disk with random 
data multiple times. For more details, see diskutil�s man page.

To erase a single volume on a disk, a slightly different command is used:

diskutil eraseVolume format name device

For example:

diskutil eraseVolume JournaledHFS+ UntitledPartition /Volumes/

OriginalPartition

Additional information about diskutil and other uses can be found in Command-Line 
Administration. For complete command syntax for diskutil, consult the tool�s man page.

Identifying Remote Servers When Installing Leopard Server
For remote server installations, you need to know this information about the target 
server:
Â The identity of the target server:  When using Server Assistant, you must be able 

to recognize the target server in a list of servers on your local subnet or you must 
enter the IP address of the server (in IPv4 format: 000.000.000.000) if it resides on 
a different subnet. Information provided for servers in the list includes IP address, 
host name, and Media Access Control (MAC) address (also called hardware or 
Ethernet address). 
If you use VNC viewer software to remotely control installation of Leopard Server 
or later, it might let you select the target server from a list of available VNC servers. 
If not, enter the IP address of the server (in IPv4 format: 000.000.000.000).

The target server�s IP address is assigned by a DHCP server on the network. If no 
DHCP server exists, the target server uses a 169.xxx.xxx.xxx address unique among 
servers on the local subnet. Later, when you set up the server, you can change 
the IP address.
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If you don�t know the IP address and the remote server is on the local subnet, you 
can use the sa_srchr command to identify computers on the local subnet where you 
can install server software. Enter the following from an existing computer with 
Mac OS X Server Tools installed:

/System/Library/Serversetup/sa_srchr 224.0.0.1

This command returns the IP address and the EthernetID (in addition to other 
information) of servers on the local subnet that have started up from the installation 
disk.

Important:  Sever Assistant uses Bonjour to look for services on the same subnet and 
generates IPv4 and IPv6 traffic in the process. To prevent IPv6 traffic, disable IPv6.

Â The preset password for the target server:  The password consists of the first eight 
digits of the server�s built-in hardware serial number. To find a server�s serial number, 
look for a label on the server. Older computers have no built-in hardware serial 
numbers. For these systems, use 12345678.

Important:  This password is valid only during setup.

Installing Server Software Interactively
You can use the installation disc to install server software interactively on a local server, 
on a remote server, or on a computer with Leopard pre-installed.

Installing Locally from the Installation Disc
You can install Leopard Server directly onto a computer with a display, a keyboard, and 
an optical drive attached.

If you have an Install DVD, the optical drive must be able to read DVD discs. 

You can also install directly onto a computer that lacks a display, keyboard, and optical 
drive capable of reading your installation disc. In this case, you start the target 
computer in target disk mode and connect it to an administrator computer using a 
FireWire cable.

You use the administrator computer to install the server software on the target 
computer�s disk or partition, which appears as a disk icon on the administrator 
computer.

These instructions assume you have started up the computer using the Install DVD, 
installer partition, or NetInstall disk. If you have not, see the relevant instructions 
beginning at �Starting Up for Installation� on page 39.

To install server software locally:
1 After the computer starts, choose the language you want the server to use and click 

Continue.
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2 When the Installer opens, use the Utilities menu to open Disk Utility to securely erase 
the target disk before proceeding. 

To securely erase and format the entire disk or partition, use Disk Utility. For more 
information, see �Using Disk Utility to Securely Erase a Disk or Partition� on page 170.

3 Proceed through the Installer�s panes by following the onscreen instructions.

4 When the Select a Destination pane appears, select a target disk or volume (partition) 
and make sure it�s in the expected state. 

If you�re doing a clean installation, click Options to format the destination disk or 
volume in Mac OS Extended (Journaled) format. Select Erase to format the disk in 
Mac OS Extended (Journaled) format; then click OK.

If the volume you select contains Mac OS X Server v10.3.9 or v10.2.8 and you want to 
upgrade, click Options, select �Don�t erase� and then click OK.

Important:  When you perform an upgrade, make sure that saved setup data won�t be 
inadvertently detected and used by the server. If saved setup data is used, the server 
settings are not compatible with the saved settings and can cause unintended 
consequences. For more information, see Server Administration.

5 At the �Install� screen, click Customize.

6 Deselect options not needed on this server.

It is recommended to not install unneeded languages.

Note:  By default, X11 is not selected. The X11 X Window system provides the ability to 
run X11-based applications under Leopard Server. Although this capability can be 
useful, it introduces configuration and security issues.

7 Click the Printer Drivers disclosure triangle to reveal printer drivers, and deselect drivers 
you don�t need.

Printer drivers can always be installed later if a printer is added.

Install only drivers for the printers that will be used.

8 Proceed through the Installer�s panes by following the onscreen instructions.

After installation is complete, the computer restarts and you can perform initial server 
setup.

9 If you�re using an administrator computer to install onto a server that�s in target disk 
mode and connected using a FireWire cable:

a Quit Server Assistant when it starts automatically on the administrator computer.
b Shut down the administrator computer and the server.
c Start up the administrator computer and the server normally (not in target disk 

mode). 
Now you can use Server Assistant from the administrator computer to remotely set up 
the server.
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To set up a server locally or remotely, see Server Administration. 

Installing Remotely with Server Assistant
To install Leopard Server on a remote server from the server Install DVD, installation 
partition, or NetInstall disk, you need an administrator computer from which to use 
Server Assistant to manage the installation, as shown here.

After the computer starts up, you can control and manage other servers from an 
administration computer in a secure environment.

Important:  If you have administrative applications and tools from Server Tiger or 
earlier, do not use them with Leopard Server.

To use the Installer user interface, use VNC to view and interact with the remote 
installer. For more information, see �Installing Remotely with VNC� on page 58.

These instructions assume you have started up the computer using the Install DVD, 
installer partition, or NetInstall disk. If you have not, see the instructions at �Starting Up 
for Installation� on page 39.

You don�t need to be an administrator on the local computer to use Server Assistant.

To install on a remote server by using Server Assistant:
1 After the target computer has started from the server Install DVD, installation partition, 

or NetInstall disk, launch Server Assistant in the /Applications/Server/ folder on the 
administrator computer.

2 Select �Install software on a remote server.�

Administrator computer

Subnet 1

Subnet 2

Welcome

>installer

>installer
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3 For every target server, identify the server and add it to the list. 

If it�s on the local subnet, select it in the list; otherwise, click the Add (+) button and 
enter an IP address in IPv4 format (000.000.000.000).

If you already have a saved server list, load it now by selecting File > Load Server List.

4 When prompted for a password, enter the first eight digits of the server�s built-in 
hardware serial number.

To find a server�s serial number, look for a label on the server.

If you�re installing on an older computer that has no built-in hardware serial number, 
use 12345678 for the password.

5 After you finish adding servers to the list, save this list for future use by selecting 
File > Save Server List.

6 Proceed by following the onscreen instructions.

7 When the Volumes pane appears, select a target disk or volume (partition), make sure 
it�s in the expected state, and click Continue. 

If the volume you select contains Mac OS X Server v10.4.11 or v10.3.9 and you 
want to upgrade, select �Don�t erase.� Otherwise, select Erase to format the disk in 
Mac OS Extended (Journaled) format; then click OK.

8 Proceed by following the onscreen instructions.

While installation proceeds, you can open another Server Assistant window to install 
server software on other computers. Choose File > New Window to do so.

After installation is complete, the target server restarts and you can perform initial 
server setup. Server Administration describes how.

Installing Remotely with VNC
If you�re using an installation disc for Leopard Server or later, you can control 
installation from another computer using open source VNC viewer software or 
Apple Remote Desktop. This allows you to remotely control preparation of 
the target disk or partition before beginning installation. 

You can partition the hard disk into multiple volumes, create a RAID set, or erase the 
target disk or partition.

WARNING:  When you perform an upgrade, make sure that saved setup data won�t be 
detected and used by the server. If saved setup data is used, the server settings are 
not compatible with the saved settings and can cause unintended consequences. For 
more information, see Server Administration.
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The process for remotely installing with VNC is the same as installing locally at the 
keyboard and monitor, except that you must first connect to the VNC server on the 
target computer with a VNC client, like Apple Remote Desktop.

For information about connecting to a computer running from an Install DVD, see 
�Remotely Accessing the Install DVD� on page 40.

For information about running the installer locally, see �Installing Locally from the 
Installation Disc� on page 55.

Installing Server Software from an Image
You can install and reinstall the server software with a known good and secure 
configuration that you previously set up on a model server using disk images.

Before creating the disk image, you might also want to securely configure additional 
server settings as described in the other chapters of this guide. Make sure the model 
server you are imaging meets the security requirements of your organization and is 
thoroughly tested.

For information about how to create and install server software with disk images, see 
Getting Started.

Secure erase can be done before or after installation. It�s best to do it before installation 
to ensure that old data is overwritten and not recoverable. Before installing server 
software from a disk image, securely erase the physical disk or partition that the image 
is being installed on using at least a 7-pass erase. For more information, see �Securely 
Erasing Data� on page 169.

Using the installer Command-Line Tool to Install Server 
Software
You use the installer tool to install server software on a local or remote computer 
from the command-line. For information about installer:
Â See Command-Line Administration.
Â Open the Terminal application and enter installer, installer -help, or man 
installer.

These instructions assume you have started up the computer using the Install DVD, 
installer partition, or NetInstall disk. If you have not, see the relevant instructions 
beginning at �Starting Up for Installation� on page 39.

If you follow the instructions for performing a clean installation, back up the user files 
you want to preserve, then use diskutil to securely erase (7-pass or 35-pass) the 
volume and format it to enable journaling.
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To securely erase a volume with 7-pass erase:
$ diskutil secureErase 2 “/Volumes/Mount 01”

For more information, see �Securely Erasing Data� on page 169. You can also use 
diskutil to partition the volume and to set up mirroring. For more information, 
see the diskutil man page.

Important:  It is not recommended to you store data on the hard disk or hard disk 
partition where the operating system is installed. This prevents you from losing data 
if you need to reinstall or upgrade system software. If you must store additional 
software or data on the system software partition, consider mirroring the drive.

To use installer to install server software: 
1 Start a command-line session with the target server by choosing from the following:

Â Installing a local server:  When the Installer opens, choose Utilities > Open Terminal 
to open the Terminal application. 

Â Installing a remote server:  From Terminal on an administrator computer or from 
a UNIX workstation, establish an SSH session as the root user with the target server, 
substituting the target server�s actual IP address for <ip address>: 
ssh root@<ip address>

If you don�t know the IP address and the remote server is on the local subnet, use the 
sa_srchr command to identify computers on the local subnet where you can install 
server software:

/System/Library/Serversetup/sa_srchr 224.0.0.1

mycomputer.example.com#PowerMac4,4#<ip address>#<mac address>#Mac OS X 

Server 10.5#RDY4PkgInstall#2.0#512

You can also use Server Assistant to generate information for computers on the local 
subnet. Open Server Assistant, select �Install software on a remote computer,� and click 
Continue to access the Destination pane and generate a list of servers awaiting 
installation.

2 When prompted for a password, enter the first eight digits of the server�s built-in 
hardware serial number.

To find a server�s serial number, look for a label on the server. If the target computer is 
set up as a server, you�ll also find the hardware serial number in /System/Library/
Serversetup/SerialNumber.

If you�re installing on an older computer that has no built-in hardware serial number, 
use 12345678 for the password.
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3 Identify the target-server volume where you want to install the server software.

To list the volumes available for server software installation from the installation disc, 
enter this command: 

/usr/sbin/installer -volinfo -pkg /System/Installation/Packages/

OSInstall.mpkg

You can also identify a NetInstall image you�ve created and mounted:

/usr/sbin/installer -volinfo -pkg /Volumes/ServerNetworkImage10.5/

System/Installation/Packages/OSInstall.mpkg

The list displayed reflects your environment, but here�s an example showing three 
available volumes: 

/Volumes/Mount 01

/Volumes/Mount1

/Volumes/Mount02

4 If you haven�t already done so, prepare the disks for installation.

For more information about preparing disks for installation, see �Preparing Disks for 
Installing Leopard Server� on page 47.

If the target volume has Mac OS X Server v10.4.10 or 10.3.9 installed, when you run 
installer it upgrades the computer to Leopard Server and preserves user files.

If you�re performing a clean installation, back up the user files you want to preserve, 
then use diskutil to erase the volume and format it to enable journaling:

/usr/sbin/diskutil eraseVolume HFS+ "Mount 01" "/Volumes/Mount 01"

/usr/sbin/diskutil enableJournal "/Volumes/Mount 01"

You can also use diskutil to partition the volume and set up mirroring. For more 
information about the command, see the diskutil man page.

Important:  It is recommended not to store data on the hard disk or hard disk partition 
where the operating system is installed. This prevents you from losing data if you need 
to reinstall or upgrade system software. If you must store additional software or data 
on the system partition, consider mirroring the drive.

5 Install the operating system on a volume from the list generated in step 3.

For example, to use Mount 01 in the example in step 3 to install from a server 
installation disc, enter: 

/usr/sbin/installer -verboseR -lang en -pkg /System/Installation/

Packages/OSInstall.mpkg -target "/Volumes/Mount 01"

If you�re using a NetInstall image, the command identifies them as step 3 shows.

When you enter the -lang parameter, use one of the following values:  en (for English), 
de (for German), fr (for French), or ja (for Japanese).
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During installation, progress information appears. While the installation proceeds, you 
can open another Terminal window to install server software on another computer.

6 When installation from the disc is complete, restart the server by entering:

/sbin/reboot

or

/sbin/shutdown -r time

Server Assistant opens when installation is complete. You can now proceed to set up 
the server. For more information, see Server Administration.

Installing Multiple Servers
To initiate multiple server software installations, you can use Server Assistant, VNC 
viewer software, or the installer tool. After using Server Assistant to initiate server 
software installation on more than one remote computer, you can choose File > New 
Window to install the software on another batch of computers.

When running Server Assistant from an administration computer to install on multiple 
machines, group the same hardware configurations together. For example, choose all 
Intel-based Xserve machines or all G4 Mac minis.

After using a VNC viewer to control installation of Leopard Server or later on a remote 
computer, you can use the VNC viewer to open a connection to another remote 
computer and control installation on it. Because this involves interacting with each 
server individually, it is a less efficient method of installing on multiple servers.

The most efficient method of installation would be completely automated. Opening 
the Terminal application and using the installer tool to initiate each server software 
installation doesn�t accomplish this efficiently. However, scripting the command-line 
tool (using known values for server IP addresses, for example) to automate multiple 
simultaneous installations can be very efficient. To completely automate server 
installation, you must script the installer tool and have a high measure of control 
over the network infrastructure.

For example, to have known IP addresses and the relevant hardware serial numbers 
included in your script, you cannot rely on the randomly assigned IP addresses. You can 
use DHCP assigned static addresses to remove that uncertainty and ease your scripting 
considerations.

The methods, scripting languages, and possibilities are too many to list in this guide.
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Upgrading a Computer from Leopard to Leopard Server
You can use the Install DVD for Leopard Server to upgrade a desktop computer that 
has the following characteristics:
Â Has Leopard or later installed
Â Has an Intel processor
Â Was introduced in summer 2006 or later
Â Meets the system requirements

To upgrade a computer from Leopard to Leopard Server:
1 Start up the computer from the hard disk, as you would for normal use.

Do not use an installation disc.

2 Insert the Install DVD, open the Other Installs folder, and double-click 
MacOSXServerInstall.mpkg to run the Installer.

When the Installer finishes, your computer restarts and Server Assistant opens to let 
you set up the server.

3 After the server restarts, use Software Update to install server software updates.

How to Keep Current
After you�ve set up your server, you�ll want to update it when Apple releases server 
software updates.

There are several ways to access update releases of Leopard Server:
Â In Server Admin, select a server in the Servers list, then click the Server Updates 

button.
Â Use the Software Update pane of System Preferences.
Â Use the softwareupdate command-line tool.
Â Use the server�s software update service.
Â Download a disk image of the software update from www.apple.com/support/

downloads.

Using Interactive Server Setup
The simplest way to set up a small number of servers is to use Server Assistant�s guided 
interview process after establishing a connection with each server in turn. You provide 
server setup data interactively, then initiate setup immediately. If you have only a few 
servers to set up, the interactive approach is useful. 

You can use the interactive approach to set up a local server, a remote server, or several 
remote servers. To use this approach, open Server Assistant, connect to target servers, 
supply setup data, and then initiate the setup immediately.

http://www.apple.com/support/downloads/
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This is the technique you use to set up a local server, as �Setting Up a Local Server 
Interactively� on page 66 describes. You can also use this interactive approach 
to set up a remote server from an administrator computer. For instructions, see 
�Setting Up a Remote Server Interactively� on page 67.

When multiple remote servers can use the same setup data, you can supply the data 
and then initiate setup of all servers at once, using a batch approach. When running 
Server Assistant from an administration computer to set up multiple servers, group the 
same hardware configurations together. For example, choose all Intel-based Xserve 
machines or all G4 Mac minis.

This technique, shown on the left side of the following illustration, requires that 
network identifiers for target servers be set using DHCP or BootP. For instructions, 
see �Setting Up Multiple Remote Servers Interactively in a Batch� on page 68.

To customize the setup of individual servers, you can manage each setup individually 
from a different Server Assistant window. This approach is shown on the right side of 
the illustration above. For instructions, see �Setting Up a Remote Server Interactively� 
on page 67.

Although the previous illustration shows target servers on the same subnet as the 
administrator computer in one scenario and target servers on a different subnet in the 
other scenario, both setup scenarios can be used to set up servers on the same and 
different subnets.

If a target server is on a different subnet, you must supply its IP address. Servers on the 
same subnet are listed by Server Assistant, so you select servers from a list.

Subnet 1

Subnet 2

WelcomeWelcome

Welcome
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To securely set up your server, note the following when providing information in the 
Assistant�s panes:

Â Password�The administrator password you specify during setup is also used for the 
root account. Because of this, take special care to ensure that this account is as 
secure as possible:
Â Limit the number of administrator accounts issues. This makes it easier to retain 

control over the computer and identify whether an activity noted in the logs was 
legitimate. 

Â When entering administrator account information for the Name and the Short 
Name fields, use names other than �administrator,� �admin,� or some form of the 
word administrator. The name alone should not identify the account as an 
administrator account.

Â Use a strong password in the Password and Verify fields. Passwords can be up to 
255 characters and contain uppercase letters, lowercase letters, numbers, and 
special characters. Choose a password that consists of at least 12 characters that 
would not be found in a dictionary, and that contains mixed-case letters, numbers, 
and special characters.

Â After setting up the administrator user, click Continue. 
Â Change the root password as soon as possible after installation is complete.

Â Computer Name and Local Hostname�The names should not indicate the purpose 
of the computer. The word �server� should not be used as the name or part of the 
name.

Â Network interfaces�Select only those interfaces that will be used and deselect all 
others. For example, if the network interface for the server will be Built-in Ethernet 
only, deselect Built-in FireWire. Do not use AppleTalk. Do not enable Remote 
Management in the Network Names screen unless it is required.

Â TCP/IP�For the Configure IPv4 setting, select �Manually.� The use of DHCP or BootP 
is not recommended. Make sure that DHCP or DNS servers you specify for the server 
you�re setting up to use are running. 

Â Directory usage�Set the �Set directory usage� setting to Standalone Server to 
simplify the installation. The type of directory usage depends on the role of the 
server being installed. For information about configuring directory usage, see 
Chapter 24, �Securing Directory Services.�

Â Server Configuration Mode�Choose Advanced for the Server Configuration Mode. 
This mode will result in a server installation with all services installed, but 
deactivated. The other two choices (Standard and Workgroup) will activate the 
services whose icons are shown. Services should only be activated when they are 
necessary.

Â Services�Do not enable services. The services you enable depend on the role of the 
server being installed. Configure each service carefully before activation. 
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Â Network time�Some authentication services, including Kerberos, require that time 
be synchronized across all computers, which necessitates synchronization with 
a timeserver. For security, one timeserver on the local network can synchronize with 
a trusted Internet timeserver, but it is the only server that should do so. Direct use 
of an Internet timeserver is not recommended for other servers.

Note:  If NTP is to be used on a network without Internet access, the server providing 
the NTP service must have another time source connected, such as a GPS unit, or 
must be set up to use an undisciplined local clock. See www.ntp.org.

Â Setup data file�If you save the setup data in a file, encrypt it using the �Save in 
Encrypted Format� option.

Setting Up a Local Server Interactively
After you install server software, you can use the interactive approach to set it up 
locally if you have physical access to the computer.

Important:  This setup assumes you are using the Advanced server configuration mode. 
It is recommended not to try to use these instructions with Standard or Workgroup 
modes.

To set up a local server interactively:
1 Fill out the Mac OS X Server Advanced Worksheet in Server Administration. 

When the server restarts, Server Assistant opens.

2 Enter the setup data you�ve recorded on the Installation & Setup Worksheet as you move 
through the Assistant�s panes, following the onscreen instructions.

Make sure that DHCP or DNS servers you specify for the server you�re setting up to use 
are running.

After you enter setup data, Server Assistant displays a summary of the data.

3 Review the setup data you entered and, if necessary, click Go Back to change it.

4 To save the setup data as a text file or in a form you can use for automatic server setup 
(a saved setup file or saved directory record), click Save As. 

To encrypt a configuration file or directory record, select �Save in Encrypted Format� 
and then enter and verify a passphrase. You must supply the passphrase before a target 
server can use an encrypted setup file.

5 To initiate setup of the local server, click Apply.

6 When server setup is complete, click Restart Now.

Now you can log in as the server administrator user created during setup to configure 
services.

http://www.ntp.org
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Setting Up a Remote Server Interactively
After server software is installed on a server, you can use the interactive approach 
to set it up remotely from an administrator computer that can connect to the 
target server.

To set up a remote server interactively:
1 Fill out the Mac OS X Server Advanced Worksheet in Server Administration. 

2 Make sure the target server is running.

3 On an administrator computer, open Server Assistant in /Applications/Server/. 

You don�t need to be an administrator on the administrator computer to use Server 
Assistant.

4 In the Welcome pane, select �Set up a remote server� and click Continue.

5 In the Destination pane, put a check in the Apply column for the remote server you 
want to set up, enter its preset password in the Password field, and click Continue to 
connect to the server.

If you don�t see the target server on the list, click Add to add it or Refresh to determine 
whether it�s available. 

6 For the server configuration type, select �Advanced.�

7 In the Language pane, specify the language you want to use to administer the target 
server.

8 If you are using saved setup data, do the following:

a In the Language pane, choose File > Open Configuration File or File > Open 
Directory Record to load the saved setup data you want to use. If the saved setup 
data is encrypted, enter the passphrase when prompted.

b Optionally, choose View > Jump to Review to review the setup data, then use Go 
Back as necessary to change it. 

9 If you are entering setup data, do the following:

a Click Continue and enter the setup data as you move through the Assistant�s panes, 
following the onscreen instructions, and click Continue.

b Make sure that the DHCP or DNS servers you specify for the server you�re setting up 
are running.

10 After you specify setup data, review the summary displayed by Server Assistant and 
optionally click Go Back to change data.

11 To save the setup data as a text file or in a form you can use for automatic server setup 
(as a saved setup file or saved directory record), click Save As. 

To encrypt a configuration file or directory record, select �Save in Encrypted Format� 
and then enter and verify a passphrase.

You must supply the passphrase before a target server can use an encrypted setup file.
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12 To initiate setup of the remote target server, click Apply.

13 When server setup is complete, click Continue Now. 

The target server restarts and you can log in as the server administrator user you 
created during setup to configure services.

Setting Up Multiple Remote Servers Interactively in a Batch
You can use the interactive approach to set up multiple servers as a batch if:
Â The servers are accessible from an administrator computer
Â The servers use the same chip platform (for example, Intel or PowerPC)
Â The servers use the same setup data, except for server software serial numbers and 

network identities (host name, computer name, and local hostname)
Â Network identities are provided by a DHCP or BootP server

When running Server Assistant from an administration computer to set up multiple 
servers, group the same hardware configurations together. For example, choose Intel-
based Xserve machines or G4 Mac minis. 

If you have servers with different configuration files, you can open a Server Assistant 
window for each server type. This way you can group servers by platform, settings, 
subnet, or other criteria you choose.

To set up multiple remote servers interactively in a batch:
1 Fill out the Mac OS X Server Advanced Worksheet in Server Administration with the 

settings you want to use for all servers you want to set up. 

2 Make sure the target servers and DHCP or DNS servers you want them to use are 
running.

3 On an administrator computer that can connect to all target servers, open Server 
Assistant located in /Applications/Server/. 

You don�t need to be an administrator on the administrator computer to use Server 
Assistant.

4 In the Welcome pane, select �Set up a remote server� and click Continue.

5 In the Destination pane, put a check in the Apply column for each remote server you 
want to set up, enter the preset password in the Password field for each server, and 
click Continue to connect to the servers.

If your target server doesn�t appear on the list, click Add to add it.

6 In the Language pane, specify the language you want to use to administer the target 
servers.
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7 If you are using saved setup data, do the following:

a In the Language pane, choose File > Open Configuration File or File > Open 
Directory Record to load the saved setup data you want to use. If the saved setup 
data is encrypted, enter the passphrase when prompted.

b Optionally, choose View > Jump to Review to review the setup data, then use Go 
Back as necessary to change it. 

8 If you are entering setup data, do the following:

a Click Continue and enter the setup data as you move through the Assistant�s panes, 
following the onscreen instructions, and click Continue.

b Make sure that DHCP or DNS servers you specify for the server you�re setting up to 
use are running.

9 After setup data is specified, review the summary displayed by Server Assistant and 
optionally click Go Back to change data.

10 To save the setup data as a text file or in a form you can use for automatic server setup 
(as a saved setup file or saved directory record), click Save As. 

To encrypt a configuration file or directory record, select �Save in Encrypted Format� 
and then enter and verify a passphrase.

You must supply the passphrase before an encrypted setup file can be used by a target 
server.

11 To initiate server setup, click Apply.

12 To initiate setup of the remote target server, click Apply.

13 When server setup is complete, click Continue Now. 

The target servers restart and you can log in as the server administrator user created 
during setup to configure their services.

Updating System Software
After installing Leopard Server, be sure to install the latest approved security updates. 
Leopard Server includes Apple Software Update, an application that downloads and 
installs software updates from Apple�s Software Update server or from an internal 
software update server. 

You can configure Software Update so that it checks for updates periodically or 
whenever you choose. You can also configure Software Update to download, but not 
install, updates, if you want to install them later.
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Before installing updates, check with your organization for their policy on downloading 
updates. They might prefer that you use an internal software update server, which 
reduces the amount of external network traffic and allows the organization to 
prequalify software updates with organization configurations before updating 
individual computers.

Important:  Security updates published by Apple contain fixes for security issues, and 
are usually released in response to a specific known security problem. Applying these 
updates is essential.

If Apple Software Update does not install an update that you request, contact your 
network administrator. Failure to update signifies that the requested update could be
a malicious file.

Important:  Before connecting to the Internet, ensure that your network services are 
securely configured. If you have not secured and validated your settings for network 
services, do not enable your network connection to install software updates. Until you 
have securely configured your network services settings, you are limited to using the 
manual method of installing software updates. For more information, see �Securing 
Software Update Preferences� on page 141.

Updating from an Internal Software Update Server
The computer automatically looks for software updates from an internal software 
update server. By using an internal software update server, you reduce the amount of 
data transferred outside of the network and your organization can control which 
updates can be installed on your computer.

If you run Software Update over a wireless or untrusted network, you run a chance of 
downloading malicious updates from a rogue software update server. However, 
Software Update will not install a package that has not been digitally signed by Apple 
before distribution.

If you connect your computer to a network that manages its client computers, the 
network can require that the computer use a specified software update server. 

To specify your software update server:
$ defaults write com.apple.SoftwareUpdate CatalogURL 

http://swupdate.example.com:8088/index.sucatalog

Replace swupdate.example.com with the fully qualified domain name (FQDN) or IP 
address of your software update server.

Note:  You can specify the software update server to use using Workgroup Manager, 
which allows you to manage Software Update preferences for multiple computers.

To delete the information about the software update server:
$ defaults delete com.apple.SoftwareUpdate CatalogURL
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Updating from Internet-Based Software Update Servers
Software Update can periodically check the Internet for software updates. Instead of 
using your computer to check for and install updates, consider using a test computer 
to download updates and verify file integrity before installing updates. You can then 
transfer the update packages to your operational computer. See �Updating Manually 
from Installer Packages� on page 71.

To download and install software updates using Software Update:
1 Choose Apple () > Software Update.

After Apple Software Update looks for updates to your installed software, it displays 
a list of updates. To get older versions of updates, go to the software update website 
at www.apple.com/support/downloads/.

2 Select the updates you want to install, and choose Update > Install and Keep Package. 

When you keep the package, it is stored in the /Library/Packages/ folder. 

If you do not want to install any of the updates, click Quit.

3 Accept the licensing agreements to start installation.

Some updates might require your computer to restart. If, after installing updates, 
software update asks you to restart the computer, do so.

Important:  Make sure updates are installed when the computer can be restarted 
without affecting the users accessing the server.

Updating Manually from Installer Packages
Software updates can be manually downloaded for Apple products from 
www.apple.com/support/downloads/ using a computer designated for downloading 
and verifying updates. The download should be done separately so that file integrity 
can be verified before the updates are installed.

You can review the contents of each security update before installing it. To see the 
contents of a security update, go to Apple�s Security Support Page at 
www.apple.com/support/security and click the �Security Updates page� link.

To manually download, verify, and install software updates:
1 Go to www.apple.com/support/downloads/ and download the software updates on

a computer designated for verifying software updates.

Note:  Updates provided through Apple Software Update might sometimes appear 
earlier than standalone updates.

2 Review the SHA-1 digest (also known as a checksum) for each update file downloaded, 
which should be posted online with the update package.

3 Check downloaded updates for viruses.

http://www.apple.com/support/downloads
http://www.apple.com/support/downloads
http://www.apple.com/support/security
http://www.apple.com/support/downloads
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4 Verify the integrity of each update.

For more information, see �Verifying the Integrity of Software� on page 72.

5 Transfer the downloaded update packages from your test computer to your current 
computer. 

The default download location for update packages is /Library/Packages/. You can 
transfer update packages to any location on your computer.

6 Double-click the package. 

If the package is located within a disk image (dmg) file, double-click the dmg file, and 
then double-click the package.

7 Proceed through the installation steps.

8 Restart the computer, if requested.

Install the relevant software update and then install subsequent security updates. 
Leopard Server ensures that the updates are installed in order by release date, oldest to 
newest.

Verifying the Integrity of Software
Software images and updates can include an SHA-1 digest, which is also known as a 
checksum. You can use this SHA-1 digest to verify the integrity of the software. 
Software updates retrieved and installed automatically from Apple Software Update 
verify the checksum before installation.

To verify software integrity:
1 Open Terminal.

2 Use the sha1 command to display a file�s SHA-1 digest.

$ /usr/bin/openssl sha1 full_path_filename

Replace full_path_filename with the full path filename of the update package or 
image for which the SHA-1 digest is being checked. 

If provided, the SHA-1 digest for each software update or image should match the 
digest created for that file. If it does not, the file was corrupted and a new copy should 
be obtained.

Repairing Disk Permissions
Permissions on files can sometimes be set incorrectly, especially during a software 
installation. Incorrect permissions can cause the computer to malfunction and even 
introduce security vulnerabilities. Repairing these permissions is recommended after 
performing any software installation on Leopard Server. 

Important:  Perform the procedure to repair disk permissions after every software 
installation, including the operating system, updates, and applications.
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Kinds of Permissions
Before you change or repair disk permissions, you should understand the two kinds of 
file and folder permissions that Leopard Server supports:
Â Portable Operating System Interface (POSIX) permissions�standard for UNIX 

operating systems
Â Access Control Lists (ACLs) permissions�used by Leopard Server, which are 

compatible with Microsoft Windows Server 2003 and Microsoft Windows XP

Note:  In this guide, the term �privileges� refers to the combination of ownership and 
permissions, while the term �permissions� refers only to the permission settings that 
each user category can have (Read & Write, Read Only, Write Only, and None).

POSIX Permissions Overview
POSIX permissions let you control access to files and folders. Every file or folder has 
read, write, and execute permissions defined for three categories of users (owner, 
group, and everyone). There are four types of standard POSIX access permissions that 
you can assign: Read & Write, Read Only, Write Only, and None.

For more information, see �Setting POSIX Permissions� on page 151.

ACL Permissions Overview
An ACL provides an extended set of permissions for a file or folder and enables you to 
set multiple users and groups as owners. An ACL is a list of access control entries 
(ACEs), each specifying the permissions to be granted or denied to a group or user, and 
how these permissions are propagated throughout a folder hierarchy. In addition, ACLs 
are compatible with Windows Server (2000, 2003, and 2008) and Windows XP, giving 
you added flexibility in a multiplatform environment.

ACLs enable you to define more detailed permissions when assigning privileges than 
POSIX permissions. For example, rather than giving a user full writing permissions, you 
can restrict him or her to the creation of only folders and not files.

If a file or folder has no ACEs defined for it, Leopard Server applies standard POSIX 
permissions. If a file or folder has one or more ACEs defined for it, Leopard Server starts 
with the first ACE in the ACL and works its way down the list until the requested 
permission is satisfied or denied. 

After evaluating the ACEs, Leopard Server evaluates the standard POSIX permissions 
defined for the file or folder. Then, based on the evaluation of ACL and standard POSIX 
permissions, Leopard Server determines what type of access a user has to a shared file 
or folder.

For more information, see �Setting ACL Permissions� on page 155.
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Using Disk Utility to Repair Disk Permissions
Installing software sometime causes file permissions to become incorrectly set. 
Incorrect file permissions can create security vulnerabilities. Disk Utility only repairs 
POSIX permissions or minimal ACL permissions.

Most software you install in Leopard Server is installed from package (.pkg) files. Each 
time something is installed from a package file, a Bill of Materials (.bom) file is stored in 
the packages receipt file. Each Bill of Materials file contains a list of files installed by that 
package, along with the proper permissions for each file.

When you use Disk Utility to verify or repair disk permissions, it reads the Bill of 
Materials files from the initial Leopard Server installation and compares its list to the 
permissions on each file listed. If the permissions differ, Disk Utility can repair them.

You should repair disk permissions if you are experiencing symptoms that indicate 
permission-related problems after installing software, software updates, or applications.

Note:  If you�ve modified permissions for files in accordance with organizational policies, 
be aware that repairing disk permissions can reset those modified permissions to those 
stated in the Bill of Materials files. After repairing permissions, reapply the file 
permission modifications to stay within your organizational policies.

To repair disk permissions:
1 Open Disk Utility.

2 Select the partition you want to repair.

Select a partition, not a drive. Partitions are contained within drives and are indented 
one level in the list on the left.

3 Click Repair Disk Permissions.

If you do not select a partition, this button is disabled.

4 Choose Disk Utility > Quit Disk Utility.

5 Choose Installer > Quit Installer, and click Restart.
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3 Protecting System Hardware

Use this chapter to learn how to protect and secure your 
system hardware.

After installing and setting up Leopard Server, make sure you protect your system 
hardware.

Protecting Hardware
The first level of security is protection from unwanted physical access. If someone can 
physically access a computer, it becomes much easier to compromise the computer�s 
security. When someone has physical access to the computer, they can install malicious 
software or event-tracking and data-capturing services.

Use as many layers of physical protection as possible. Restrict access to rooms that 
contain computers that store or access sensitive information. Provide room access only 
to those who must use those computers. If possible, lock the computer in a locked or 
secure container when it is not in use, and bolt or fasten it to a wall or piece of 
furniture.

The hard disk is the most critical hardware component in your computer. Take special 
care to prevent access to the hard disk. If someone removes your hard disk and installs 
it in another computer, they can bypass safeguards you set up. Lock or secure the 
computer�s internal hardware. 

If you can�t guarantee the physical security of the hard disk, consider using FileVault for 
each home folder. FileVault encrypts home folder content and prevents the content 
from being compromised. For more information, see �Encrypting Home Folders� on 
page 162.

If you have a portable computer, keep it secure. Lock it up or hide it when it is not in 
use. When transporting the computer, never leave it in an insecure location. Consider 
buying a computer bag with a locking mechanism and lock the computer in the bag 
when you aren�t using it.
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Preventing Wireless Eavesdropping
Most network environments have wired and wireless access to the network. 
Wireless access helps businesses or organizations offer mobility to users throughout 
their network. 

Although wireless technology gives your network more flexibility with your users, it can 
cause security vulnerabilities you may be unaware of. It is recommended that wherever 
possible, wireless access be disabled for security reasons. When using a wireless access 
point, make sure you properly configure the security settings to prevent unauthorized 
users from attempting to access your network. 

Your wireless access point should require encryption of the connection, user 
authentication (through the use of certificates or smart cards), and time-outs for 
connections. 

By requiring an encrypted wireless connection, you can maintain the integrity and 
confidentiality of data being transmitted to your wireless access point. The use of 
certificates or smart cards helps to ensure the users� identity, that your users are who 
they say they are. 

Also, setting a time-out that disconnects wireless user connections lasting longer than 
8 to 10 hours prevents your network from being attacked by a computer that is 
connected through your wireless access point and left unattended.

If you need to use Wi-Fi, see Mac OS X Security Configuration for information about how 
to leverage 802.1X for securing your Wi-Fi traffic.

Understanding Wireless Security Challenges
Most Mac computers have a built-in wireless network card. Users can configure their 
computer to be a wireless access point in order to share their Internet connection with 
other users. However, such a wireless access point isn�t usually secure, thereby creating 
a point of access for an attacker. 

Anyone within wireless range can gain access to your network by using an authorized 
user�s insecurely configured wireless LAN. These possible points of access can be very 
large, depending on the number of users with wireless technology on their computers. 

The challenge arises when trying to prevent users from creating access points to your 
network or trying to identify where the access points are and who is attempting to use 
them.
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Many organizations restrict the use of wireless technology in their network 
environment. However, most Mac computers have wireless capability built in, and 
simply turning it off may not meet your organization�s wireless technology restrictions. 
You might need to remove components from Mac OS X to disable them from being 
turned on in System Preferences.

OS Components
Special hardware, such as wireless networking cards and audio/video components, 
need driver software that runs at the kernel level. This driver software is implemented 
as kernel extensions (�kexts�) in Mac OS X, also known as OS components. These kernel 
extensions can be removed from Mac OS X to prevent the use of a piece of hardware.

Disabling or removing OS components or kernel extensions will alter the behavior or 
performance of the system.

Important:  Mac OS X sometimes has updates to specific OS components. When your 
computer installs these updates the component is overwritten or reinstalled if it was 
previously removed. This then reenables the hardware you wanted disabled. When you 
install updates make sure that the installation does not reenable an OS component you 
wanted disabled.

Removing Wi-Fi Hardware
Use the following instructions for removing AirPort support. This task requires 
administrator privileges.

You can also have an Apple Authorized Technician remove AirPort hardware from your 
Apple computer.

Important:  Repeat these instructions every time a system update is installed.

To remove kernel extensions for AirPort hardware:
1 Open the /System/Library/Extensions folder.

2 Drag the following files to the Trash:

AppleAirPort.kext

AppleAirPort2.kext

AppleAirPortFW.kext

3 Open Terminal and enter the following command:

$ sudo touch /System/Library/Extensions

The touch command changes the modified date of the /System/Library/Extensions 
folder. When the folder has a new modified date, the Extension cache files 
(located in /System/Library/) are deleted and rebuilt by Leopard.

4 Choose Finder > Secure Empty Trash to delete the files.

5 Restart the system.
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From the Command Line:

Removing Bluetooth Support Software
Use the following instructions to remove Bluetooth® support for peripherals such as 
keyboards, mice, or phones. This task requires administrator privileges.

Note:  You can use a policy to disable Bluetooth support by managing Bluetooth 
preferences in Workgroup Manager.

You can also have an Apple Authorized Technician remove the built-in Bluetooth 
hardware support from your Apple computer.

Important:  Repeat these instructions every time a system update is installed.

To remove kernel extensions for Bluetooth:
1 Open the /System/Library/Extensions folder.

2 Drag the following files to the Trash:

IOBluetoothFamily.kext

IOBluetoothHIDDriver.kext

3 Open Terminal and enter the following command:

$ sudo touch /System/Library/Extensions

The touch command changes the modified date of the /System/Library/Extensions 
folder. When the folder has a new modified date, the Extension cache files 
(located in /System/Library/) are deleted and rebuilt by Leopard.

4 Choose Finder > Secure Empty Trash to delete the files.

5 Restart the system.

# -------------------------------------------------------------------

# Protecting System Hardware

# -------------------------------------------------------------------

# Securing Wi-Fi Hardware

# -----------------------

# Remove AppleAirport kernel extensions

srm -r /System/Library/Extensions/AppleAirPort.kext

srm -r /System/Library/Extensions/AppleAirPort2.kext

srm -r /System/Library/Extensions/AppleAirPortFW.kext

# Remove Extensions cache files

touch /System/Library/Extensions
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From the Command Line:

Removing IR Support Software
Use the following instructions to remove IR hardware support. This task requires you to 
have administrator privileges.

You can also have an Apple Authorized Technician remove IR hardware from your 
Apple computer.

Important:  Repeat these instructions every time a system update is installed.

To remove kernel extensions for IR hardware support:
1 Open the /System/Library/Extensions folder.

2 Drag the following file to the Trash:

AppleIRController.kext

3 Open Terminal and enter the following command:

$ sudo touch /System/Library/Extensions

The touch command changes the modified date of the /System/Library/Extensions 
folder. When the folder has a new modified date, the Extension cache files (located in 
/System/Library) are deleted and rebuilt automatically by Mac OS X.

4 Choose Finder > Secure Empty Trash to delete the file.

5 Restart the system.

From the Command LIne:

# Removing BlueTooth Software

# ---------------------------

# Remove Bluetooth kernel extensions

srm -r /System/Library/Extensions/IOBluetoothFamily.kext

srm -r /System/Library/Extensions/IOBluetoothHIDDriver.kext

# Remove Extensions cache files

touch /System/Library/Extensions

# Removing IR Support Software

# -----------------------------

# Remove IR kernel extensions.

srm -rf /System/Library/Extensions/AppleIRController.kext

# Remove Extensions cache files.

touch /System/Library/Extensions
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Preventing Unauthorized Recording
You computer might be in an environment where recording devices, such as cameras 
or microphones are not permitted. You can protect your organization�s privacy by 
disabling these devices. This task requires administrator privileges.

Note:  Some organizations insert a dummy plug in to the audio input and output ports 
to ensure that the audio hardware is disabled.

Removing Audio Recording Support
Use the following instructions to remove support for the microphone.

You can also have an Apple Authorized Technician remove the built-in microphone 
hardware from your Apple computer.

Important:  Repeat these instructions every time a system update is installed.

To remove kernel extensions for audio hardware:
1 Open the /System/Library/Extensions folder.

2 To remove support for audio components such as the microphone, drag the following 
files to the Trash:

AppleOnboardAudio.kext

AppleUSBAudio.kext

AudioDeviceTreeUpdater.kext

IOAudioFamily.kext

VirtualAudioDriver.kext

3 Open Terminal and enter the following command:

$ sudo touch /System/Library/Extensions

The touch command changes the modified date of the /System/Library/Extensions 
folder. When the folder has a new modified date, the Extension cache files 
(located in /System/Library/) are deleted and rebuilt automatically by Leopard.

4 Choose Finder > Secure Empty Trash to delete the files.

5 Restart the system.
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From the Command Line:

Removing Video Recording Support Software
Use the following instructions to remove support for an external or built-in iSight 
camera. 

Note:  The support for external iSight cameras should be removed on all machines; 
removing only support for internal iSight cameras will still leave support for external 
cameras available.

These instructions do not remove support for internal iSight cameras shipping on some 
Macintosh systems. There is currently no way to disable this camera software without 
disabling all USB drivers, which also disables other peripherals such as the keyboard 
and mouse. This task requires you to have administrator privileges.

You can also have an Apple Authorized Technician remove the built-in video camera 
hardware from your Apple computer.

Important:  Repeat these instructions every time a system update is installed.

To remove kernel extensions for video hardware:
1 Open the /System/Library/Extensions folder.

2 To remove support for the external iSight camera, drag the following file to the Trash:

Apple_iSight.kext

3 To remove support for the built-in iSight camera:

a Control-click IOUSBFamily.kext and choose Show Package Contents. 
b Open the /Contents/PlugIns/ folder. 
c Drag the following file to the Trash: 

Â AppleUSBVideoSupport.kext

# Removing Audio Recording Software

# ---------------------------------

# Remove Audio Recording kernel extensions

srm -r /System/Library/Extensions/AppleOnboardAudio.kext

srm -r /System/Library/Extensions/AppleUSBAudio.kext

srm -r /System/Library/Extensions/AppleDeviceTreeUpdater.kext

srm -r /System/Library/Extensions/IOAudioFamily.kext

srm -r /System/Library/Extensions/VirtualAudioDriver.kext

# Remove Extensions cache files

touch /System/Library/Extensions
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4 Open Terminal and enter the following command:

$ sudo touch /System/Library/Extensions

The touch command changes the modified date of the /System/Library/Extensions 
folder. When the folder has a new modified date, the Extension cache files 
(located in /System/Library/) are deleted and rebuilt by Leopard.

5 Choose Finder > Secure Empty Trash to delete the files.

6 Restart the system.

From the Command Line:

Preventing Data Port Access
You computer�s data ports can be easily compromised if your machine is unattended 
for a long period of time or is stolen. To keep your machine from being compromised, 
always keep it in a locked environment or hidden when you are not using it. 

You can protect your system by preventing an unauthorized user from using your data 
ports. This keeps them from booting to a different volume using a USB Flash drive, USB, 
or FireWire external hard drive. This task requires administrator privileges.

Also by setting a firmware password using the Firmware Password Utility, you can 
prevent a physical Direct Memory Access (DMA) attack over Firewire. When the 
firmware password is set, any external device is denied direct access to computer 
memory content. For more information about the Firmware Password Utility, see �Using 
the Firmware Password Utility� on page 87.

Securing USB Hardware
Use the following instructions to remove USB mass storage device input/output 
support such as USB Flash drives and external USB hard drives. 

# Removing Video Recording Software

# ---------------------------------

# Remove Video Recording kernel extensions. 

# Remove external iSight camera. 

srm -rf /System/Library/Extensions/Apple_iSight.kext 

# Remove internal iSight camera. 

srm -rf /System/Library/Extensions/IOUSBFamily.kext/Contents/PlugIns/ 

AppleUSBVideoSupport.kext

# Remove Extensions cache files.

touch /System/Library/Extensions
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Note:  You can use a policy to control access to USB storage devices by managing USB 
preferences in Workgroup Manager.

The removal of this kernel extension only affects USB mass storage devices. It does not 
affect other USB devices such as a USB printer, mouse, or keyboard. This task requires 
administrator privileges.

Important:  Repeat these instructions every time a system update is installed.

To remove kernel extensions for specific hardware:
1 Open the /System/Library/Extensions folder.

2 To remove support for USB mass storage devices, drag the following file to the Trash:

IOUSBMassStorageClass.kext

3 Open Terminal and enter the following command:

$ sudo touch /System/Library/Extensions

The touch command changes the modified date of the /System/Library/Extensions 
folder. When the folder has a new modified date, the Extension cache files 
(located in /System/Library/) are deleted and rebuilt automatically by Leopard.

4 Choose Finder > Secure Empty Trash to delete the file.

5 Restart the system.

From the Command Line:

Removing FireWire Support Software
Use the following instructions to remove Firewire input/output support for 
components such as an external Firewire hard disk. This task requires administrator 
privileges.

Important:  Repeat these instructions every time a system update is installed.

To remove kernel extensions for certain hardware:
1 Open the /System/Library/Extensions folder.

2 To remove support for Firewire mass storage devices, drag the following file to the 
Trash:

IOFireWireSerialBusProtocolTransport.kext

# Removing USB Support

# --------------------

# Remove USB kernel extensions

srm -r /System/Library/Extensions/IOUSBMassStorageClass.kext

# Remove Extensions cache files

touch /System/Library/Extensions
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3 Open Terminal and enter the following command:

$ sudo touch /System/Library/Extensions

The touch command changes the modified date of the /System/Library/Extensions 
folder. When the folder has a new modified date, the Extension cache files 
(located in /System/Library/) are deleted and rebuilt by Leopard.

4 Choose Finder > Secure Empty Trash to delete the file.

5 Restart the system.

From the Command Line:

System Hardware Modifications
Removing the kernel extensions does not permanently disable components; however, 
administrative access is needed to restore and reload them. 

Although disabling hardware in this manner is not as secure as physically disabling 
hardware, it is more secure than only disabling hardware through System Preferences. 
This method of disabling hardware components might not be sufficient to meet a site 
security policy. Consult operational policy to determine if this method is adequate.

Authorized AppleCare Certified Technicians
If your environment does not permit the use of the following hardware components, 
you must physically disable them:
Â AirPort
Â Bluetooth
Â Microphone
Â Camera IR Port

Important:  Attempting to remove components without the use of an Apple Certified 
technician will void your warranty.

# Securing FireWire Hardware

# -----------------------------

# Remove FireWire kernel extensions

srm -r /System/Library/Extensions/IOFireWireSerialBusProtocolTransport.kext

# Remove Extensions cache files

touch /System/Library/Extensions
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A limited number of Apple Certified technicians can remove preapproved components. 
An Apple Certified Technician can remove the component without voiding the 
warranty on your computer. After an Apple Certified Technician removes the 
component the technician logs a special note with Apple Care indicating that the 
computer has had a component properly removed. Most components removed by 
Apple technicians can be reinstalled if needed. 

To locate a Certified Apple Technician go to www.apple.com/buy.

For more information, see your local Apple representative.

Note:  If you are in a government organization and need a letter of volatility for Apple 
products, send your request to AppleFederal@apple.com.

http://www.apple.com/buy
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4 Securing Global System Settings

Use this chapter to learn how to secure global system 
settings, secure Open Firmware and Leopard Server startup, 
and to use log files to monitor system activity.

After installing and setting up Leopard Server, make sure you protect your hardware 
and secure global system settings.

Securing System Startup
When a computer starts up, it first starts Extensible Firmware Interface (EFI) or Open 
Firmware. EFI is the software link between the motherboard hardware and the software 
operating system. Open Firmware is similar to EFI, but it runs on PowerPC-based 
Macintosh computers. EFI and Open Firmware determine which partition or disk to 
load Leopard from. They also determine whether the user can enter single-user mode.

Single-user mode logs in the user as root. This is dangerous because root user access is 
the most powerful level of access, and actions performed as root are anonymous.

If you create an Open Firmware or EFI password, you prevent users from accessing 
single-user mode. The password also stops users from loading unapproved partitions 
or disks and from enabling target disk mode at startup.

After creating an Open Firmware or EFI password, you must enter this password when 
you start the computer from an alternate disk (for situations such as hard disk failure or 
file system repair).

To secure startup, perform one of the following tasks:
Â Use the Firmware Password Utility to set the Open Firmware password.
Â Set the Open Firmware password within Open Firmware.
Â Verify and set the security mode from the command line.

WARNING:  EFI and Open Firmware settings are critical. Take great care when 
modifying these settings and when creating a secure Firmware password.
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An Open Firmware password provides some protection but it can be reset if a user has 
physical access to the machine and can change the physical memory configuration of 
the machine.

Open Firmware password protection can be bypassed if the user changes the physical 
memory configuration of the machine and then resets the PRAM three times (by 
holding down Command, Option, P, and R keys during system startup). 

For more information about Open Firmware password protection, see:

Â AppleCare Knowledge Base article # 06482, �Setting up Open Firmware Password 
protection in Mac OS X 10.1 or later� (www.apple.com/support/)

Â AppleCare Knowledge Base article # 07666, �Open Firmware: Password Not 
Recognized when it Contains the Letter �U�� (www.apple.com/support/)

PowerPC-Based Systems
PowerPC-based computers use Open Firmware to control hardware. This is similar to 
the BIOS on an x86 PC. Open Firmware is the hardware base layer for Leopard and is a 
possible point of intrusion. By protecting it from unauthorized access, you can prevent 
attackers from gaining access to your computer. 

Using the Firmware Password Utility
The Leopard installation disc includes Firmware Password Utility, which you can use to 
enable an Open Firmware or EFI password.

To use the Firmware Password Utility:
1 Log in with an administrator account and open the Firmware Password Utility (located 

on the Leopard installation disc in /Applications/Utilities/).

2 Click Change.

3 Select �Require password to change Open Firmware settings.�

To disable the Open Firmware or EFI password, deselect �Require password to change 
Open Firmware settings.� You won�t need to enter a password and verify it. Disabling 
the Open Firmware password is only recommended for installing Leopard.

4 In the Password and Verify fields, enter a new Open Firmware or EFI password, and click 
OK.

This password can be up to eight characters.

Do not use the capital letter �U� in an Open Firmware password. If you do, your 
password is not recognized during the startup process.

5 Close the Firmware Password Utility.

http://www.apple.com/support/
http://www.apple.com/support/
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You can test your settings by attempting to start up in single-user mode. Restart the 
computer while holding down the Command and S keys. If the login window loads, 
changes made by the Firmware Password Utility were completed successfully.

Configuring Open Firmware Settings
You can securely configure Open Firmware settings by setting a firmware password.

These instructions only apply to PowerPC-based Macintosh computers. If you are using 
an Intel-based Macintosh computer, use the Firmware Password Utility instead.

To configure Open Firmware settings in Open Firmware:
1 Restart the computer while holding down the Command, Option, O, and F keys.

This loads Open Firmware.

2 At the following prompt, change the password:

> password

3 Enter a new password and verify it when prompted.

This password can be up to eight characters.

Do not use the capital letter �U� in an Open Firmware password.

4 Enable command mode:

> setenv security-mode command

In command mode the computer starts up from the partition selected in the Startup 
Disk pane of System Preferences.

You can also enable full mode. Full mode is more restrictive than command mode. 
After enabling full mode, Open Firmware commands require you to enter your Open 
Firmware password. This includes the boot command, so Leopard will not start up 
unless you enter boot and authenticate with the Open Firmware password. 

To enable full mode, enter:

> setenv security-mode full

5 Restart the computer and enable Open Firmware settings with the following 
command:

> reset-all

The login window should appear after restarting.

WARNING:  Modifying critical system files can cause unexpected issues. Your modified 
files can also be overwritten during software updates. Make these modifications on a 
test computer first, and thoroughly test your changes every time you change your 
system configuration.
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To test your settings, attempt to start up in single-user mode. Restart the computer 
while holding down the Command and S keys. If the login window appears, your Open 
Firmware settings are set correctly.

Using Command-Line Tools for Secure Startup
You can also configure Open Firmware or EFI from the command line by using the 
nvram tool. However, only the security-mode environment variable can be securely set. 

You can set the security mode to one of the following values:
Â None:  This is the default value of security mode and provides no security to your 

computers Open Firmware.
Â Command:  This value requires a password if changes are made to Open Firmware or 

a user attempts to start up from an alternate volume or device.
Â Full:  This value requires a password to start up or restart your computer. It also 

requires a password to make changes to Open Firmware.

For example, to set the security-mode to full you would use the following command:

$ sudo nvram setsecurity-mode = “Full”

Do not set the security-password variable with nvram because the password is visible 
when viewing the environment variable list. The nvram tool requires system 
administrator or root access to set environment variables.

To securely set the password for EFI, use the Firmware Password Utility.

From the Command Line:

Intel-Based Systems
Intel-based computers use EFI to control low-level hardware. EFI is similar to BIOS on an 
x86 PC and is the hardware base layer for Leopard computers with Intel processors. By 
protecting it from unauthorized access you can prevent attackers from gaining access 
to your computer.

# Securing Global System Settings

# -------------------------------------------------------------------------

# Configuring Open Firmware Settings

# ----------------------------------

# Secure startup by setting security-mode. Replace $mode-value with

# “command” or “full”.

nvram security-mode=”$mode-value”

# Verify security-mode setting.

nvram -p
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EFI and PowerPC-based computers can use the Firmware Password Utility to password 
protect the hardware layer. For information on using the Firmware Password Utility, see 
�Using the Firmware Password Utility� on page 87.

Configuring Access Warnings
You can use a login window or Terminal access warning to provide notice of a 
computer�s ownership, to warn against unauthorized access, or to remind authorized 
users of their consent to monitoring.

Important:  Every service enabled on the system must have a banner that displays the 
relevant access warning before authentication. For more information about enabling 
banners for services, see the relevant man pages and open source projects.

Enabling Access Warnings for the Login Window
Before enabling an access warning, review your organization�s policy for what to use as 
an access warning.

When a user tries to access the computer�s login window (locally or through Apple 
Remote Desktop), the user sees the access warning you create, such as the following:

To create a login window access warning:
1 Open Terminal and verify that your logged-in account can use sudo to perform a 

defaults write.

2 Change your login window access warning:

$ sudo defaults write /Library/Preferences/com.apple.loginwindow 

LoginwindowText “Warning Text”

Replace Warning Text with your access warning text.

3 Log out to test your changes.

Your access warning text appears below the Mac OS X subtitle.

From the Command Line:

# Enabling Access Warning for the Login Window

# ----------------------------------

# Create a login window access warning.

defaults write /Library/Preferences/com.apple.loginwindow LoginwindowText 

“Warning Text”

# You can also used the BannerSample project to create an access warning.
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AuthPlugin Architecture
AuthPlugins are used to control access to a service or application. The preinstalled 
AuthPlugins for Leopard are located in the /System/Library/CoreServices/ 
SecurtiyAgentPlugins/ folder. These plug-ins, along with their associated rules and 
authorization rights for users, are defined in the /etc/authorization database, and are 
queried by the security server. 

For more information about /etc/authorization, see �Managing Authorization Rights� 
on page 374.

The following graphic shows the workflow of the Security Server. 

When an application requests authorization rights from the security server the security 
server interrogates the rights database (/etc/authorization) to determine the 
mechanisms to be used for authentication. If necessary, the security server requests 
user interaction through the security agent. The security agent then prompts the user 
to authenticate through the use of a password, biometric, or Smart Card device. Then 
the security agent sends the authentication information back to the security server, 
which passes it back to the application.
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The BannerSample Project
If your computer has developer tools installed, the sample code for the banner sample 
project is located in /Developer/examples/security/bannersample. You can modify and 
customize this sample banner code for your organization. 

After you compile the code you can place it in the /Library/Security/
SecurityAgentPlugins/ folder. Then modify the key system.login.console in the /etc/
authorization file using Terminal.

For more information about the bannersample, see the bannersample README file.

To modify the /etc/authorization file:
1 Open Terminal.

2 Enter the following command:

$ sudo pico /etc/authorization

3 Locate the system.login.console key.

4 Add <string>bannersample:test</string> above <string> builtin:smartcard-
siffer,privileged</string>, as shown in bold below:

<key>system.login.console</key>

<dict>

<key>class</key>

<string>evaluate-mechanisms</string>

<key>comment</key>

<string>Login mechanism based rule. Not for general use, yet.</string>

<key>mechanisms</key>

<array>

<string>bannersample:test</string>

<string>builtin:smartcard-sniffer,privileged</string>

5 Save changes and exit the editor.

6 Restart the computer and verify that the banner appears.
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Enabling Access Warnings for the Command Line
Before enabling an access warning, review your organization�s policy for what to use as 
an access warning.

When a user opens Terminal locally or connects to the computer remotely, the user 
sees the access warning you create. The following task must be performed by an 
administrator user. You can use any text editor.

To create a command-line access warning:
1 Open Terminal.

2 Enter the following command to create the /etc/motd file:

$ sudo touch /etc/motd

3 Enter the following command to edit the /etc/motd file:

$ sudo pico /etc/motd 

4 Enter in your access warning message.

5 Save changes and exit the text editor.

6 Open a new Terminal window to test changes.

Your access warning text appears above the prompt in the new Terminal window.
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5 Securing Local Server Accounts

Use this chapter to learn how to secure accounts by assigning 
user account types, by configuring directory access, by using 
strong authentication procedures, and by safely storing 
credentials.

Securing user accounts requires determining how accounts are used and setting the 
level of access for users.

When you define a user�s account you specify the information to prove the user�s 
identity, such as user name, authentication method (password, digital token, smart 
card, or biometric reader), and user identification number (user ID). Other information 
in a user�s account is needed by various services�to determine what the user is 
authorized to do and to personalize the user�s environment.

Types of User Accounts
When you log in to Mac OS X Server, you use a nonadministrator or administrator 
account. The main difference is that Mac OS X Server provides safety mechanisms to 
prevent nonadministrator users from editing key preferences and from performing 
actions critical to computer security. Administrator users are not as limited as 
nonadministrator users.

Nonadministrator and administrator accounts can be further defined by specifying 
additional user privileges or restrictions.

The following explains the types of user accounts.

User Account User Access

Standard nonadministrator Nonprivileged user access

Managed nonadministrator Restricted user access

Server administrator Administer the server configuration

Directory domain administrator Administer the configured domains on the server

System administrator (root) Unrestricted access to the server
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Unless you need administrator access for specific system maintenance tasks that 
cannot be accomplished by authenticating with the administrator�s account while 
logged in as a normal user, always log in as a nonadministrator user. Log out of the 
administrator account when you are not using the computer as an administrator. 
Never browse the web or check email while logged in to an administrator�s account.

If you are logged in as an administrator, you are granted privileges and abilities that 
you might not need. For example, you can potentially modify system preferences 
without being required to authenticate. This authentication bypasses a security 
safeguard that prevents malicious or accidental modification of system preferences.

Note:  This chapter describes how to secure local accounts configured on 
Leopard Server. For more information about securing user and group network accounts 
using Workgroup Manager, see Chapter 11, �Securing Accounts and Share Points.�

Guidelines for Securing Accounts
When you create user accounts, follow these guidelines:
Â Never create accounts that are shared by several users. Each user should have his or 

her own standard or managed account.
Individual accounts are necessary to maintain accountability. System logs can track 
activities for each user account, but if several users share the same account it is 
difficult to track which user performed an activity. Similarly, if several administrators 
share an administrator account, it becomes harder to track which administrator 
performed an action.

If someone compromises a shared account, it is less likely to be noticed. Users might 
mistake malicious actions performed by an intruder for legitimate actions by a user 
sharing the account.

Â Each user needing administrator access should have an administrator account in 
addition to a standard or managed account. 
Administrator users should only use their administrator accounts for administrator 
purposes. By requiring an administrator to have a personal account for typical use 
and an administrator account for administrator purposes, you reduce the risk of an 
administrator performing actions like accidentally reconfiguring secure system 
preferences.

Defining User IDs
A user ID is a number that uniquely identifies a user. Mac OS X Server computers use 
the user ID to track a user�s folder and file ownership. When a user creates a folder or 
file, the user ID is stored as the creator ID. A user with that user ID has read and write 
permissions to the folder or file by default.
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The user ID is a unique string of digits between 500 and 2,147,483,648. New users 
created using the Accounts pane of System Preferences are assigned user IDs starting 
at 501. 

It is risky to assign the same user ID to different users, because two users with the 
same user ID have identical directory and POSIX file permissions. However, each 
user has a unique GUID that is generated when the user account is created. Your 
GUID is associated with ACL permissions that are set on files or folders. By setting 
ACLs permissions you can prevent users with identical user IDs from accessing files 
and folders.

The user ID 0 is reserved for the root user. User IDs below 100 are reserved for system 
use; user accounts with these user IDs should not be deleted and should not be 
modified except to change the password of the root user. 

If you don�t want the user name to appear in the login window of a client computer, 
assign a user ID of less than 500 and enter the following command in a Terminal 
window:

sudo defaults write /Library/Preferences/com.apple.loginwindow Hide500Users 

-bool YES

User names never appear in the login window in Leopard Server.

In general, after a user ID is assigned and the user starts creating files and folders, you 
shouldn�t change the user ID.

One possible scenario in which you might need to change a user ID is when merging 
users created on different servers onto a new server or cluster of servers. The same user 
ID might have been associated with a different user on the previous server.

Securing the Guest Account
The guest account is used to give a user temporary access to your computer. The guest 
account should be disabled by default because it does not require a password to log in 
on the computer. If this account is enabled and is not securely configured, malicious 
users can gain access to your computer without the use of a password. 

If you enable the guest account, enable parental controls (using Workgroup Manager) 
to limit what the user can do and disable access to shared files and folders by 
deselecting the �Allow guest to connect to shared folders� checkbox. If you permit the 
guest account to access shared folders, an attacker can easily attempt to access shared 
folders without a password.

When you finish with this account, disable it by deselecting the �Allow guests to log 
into this computer.� This prevents the guest account from logging into the computer.
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Securing Nonadministrator Accounts
There are two types of nonadministrator accounts: standard and managed. 
Â Standard users don�t have administrator privileges and don�t have parental controls 

limiting their actions. 
Â Managed users don�t have administrator privileges but they have active parental 

controls. Parental controls help deter unsophisticated users from performing 
malicious activities. They can also help prevent users from misusing their computer.

Note:  If your computer is connected to a network, a managed user can also be a user 
whose preferences and account information are managed through the network.

When creating nonadministrator accounts, restrict the accounts so they can only use 
what is required. For example, if you plan to store sensitive data on your local 
computer, disable the ability to burn DVDs.

Securing Administrator Accounts
Each administrator should have two accounts: a standard account for daily use and an 
administrator account for administrator access. Remember that the non-administrative 
account should be used for most daily activity, especially when accessing the network 
or Internet. The administrator�s account should only be used when absolutely necessary 
to accomplish administrative tasks. 

To secure administrator accounts, restrict the distribution of administrator accounts 
and limit the use of such accounts.

A user account with administrator privileges can perform standard user and 
administrator tasks such as:

Â Creating user accounts
Â Adding users to the Admin group
Â Changing the FileVault master password
Â Enabling or disabling sharing
Â Enabling, disabling, or changing firewall settings
Â Changing other protected areas in System Preferences
Â Installing system software
Â Escalating privileges to root
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Securing the Directory Domain Administrator Account
A directory domain can reside on a computer running Leopard Server (for example, the 
LDAP folder of an Open Directory master, or other read/write directory domain) or it 
can reside on a non-Apple server (for example, a non-Apple LDAP or Active Directory 
server). Only a directory domain administrator can change the directory domain, 
including the managed accounts in the directory domain.

When configuring a directory domain administrator account, follow the same security 
guidelines as you would with any other administrator account.

You can modify the /etc/authorization configuration file to change authorizations for 
administrators and standard users. 

To modify authorization by changing the /etc/authorization file:
1 Edit the /etc/authorization file using the pico tool, which allows for safe editing of 

the file. 

The command must be run as root:

$sudo pico /etc/authorization

2 When prompted, enter the administrator password.

This displays a property list for authorization, listing all available keys.

3 Locate the key you want to modify. 

For example, to change who has access to unlock the screensaver, modify the 
system.login.screensaver key by changing the rule:

<key>rule</key>

<string>authenticate-session-owner-or-admin</string>

to 

<key>rule</key>

<string>authenticate-session-owner</string>

Doing this restricts the administrator from unlocking the screensaver. 

4 Save and quit pico.

Securing the System Administrator Account
The most powerful user account in Leopard is the system administrator or root 
account. By default, the root account on Leopard Server is enabled and uses the 
same password as the first created admin user. You should disable it using the 
following command:
$ dsenableroot -d

Important:  The system administrator or root account should only be used when 
absolutely necessary.
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The root account is primarily used for performing UNIX commands. Generally, actions 
that involve critical system files require you to perform those actions as root. However, 
thanks to the sudo command, it is not necessary to leave the root account enabled in 
order to obtain root privileges.

If you are logged in as a Leopard Server administrator, you can perform commands 
with root privileges using the sudo command. You can use sudo to perform these 
commands even if the root account has been disabled. Leopard Server logs actions 
performed using the sudo command. This helps you track misuse of the sudo command 
and root privileges on a computer. Keep in mind that these logs can be edited if they 
are stored locally, so only grant sudo privileges to trusted users.

You can use the su command to log in to the command line as another user if you 
have that user�s password. This includes the root user, if the root account is enabled. 
Once logged in as root, you can use the su command to change users without 
a password.

If you do decide to leave the root account disabled, you should still restrict access 
to the root account. If multiple users can log in as root, you cannot track which user 
performed root actions. 

Do not allow direct root login, because the logs cannot identify which administrator 
logged in. Instead, log in using accounts with administrator privilege, and then use the 
sudo command to perform actions as root. 

For instructions about how to restrict root user access in Directory Utility, open 
Mac Help and search for �Directory Utility.�

Restricting sudo Usage
By default, sudo is enabled for administrator users. From the command line, you can 
disable root login or restrict the use of sudo. Limit the administrators allowed to use 
sudo to those who require the ability to run commands as root.

The computer uses a file named /etc/sudoers to determine which users can use sudo. 
You can modify root user access by changing the /etc/sudoers file to restrict sudo 
access to specific accounts, and allow those accounts to perform specifically allowed 
commands. This gives you control over what users can do as root. 

To restrict sudo usage by changing the /etc/sudoers file:
1 As the root user, use the following command to edit the /etc/sudoers file, which allows 

for safe editing of the file. 

$ sudo visudo
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2 When prompted, enter the administrator password.

There is a timeout value associated with sudo. This value indicates the number of 
minutes until sudo prompts for a password again. The default value is 5, which means 
that after issuing the sudo command and entering the correct password, additional 
sudo commands can be entered for 5 minutes without reentering the password. 

This value is set in the /etc/sudoers file. For more information, see the sudo and sudoers 
man pages.

3 In the Defaults specification section of the file, add the following lines.

Defaults timestamp_timeout=0

Defaults tty_tickets

These lines limit the use of the sudo command to a single command per 
authentication and also ensure that, even if a timeout is activated, that later sudo 
commands are limited to the terminal in which authentication occurred.

4 Restrict which administrators are allowed to run sudo by removing the line that begins 
with %admin and add the following entry for each user, substituting the user�s short 
name for the word user:

user ALL=(ALL) ALL

Doing this means that when an administrator is added to the computer, the 
administrator must be added to the /etc/sudoers file as described, if the administrator 
needs to use sudo.

5 Save and quit visudo.

For more information, enter man pico or man visudo in a Terminal window. For 
information about how to modify the /etc/sudoers file, see the sudoers man page.

Understanding Directory Domains
User accounts are stored in a directory domain. Your preferences and account 
attributes are set according to the information stored in the directory domain.

Local accounts are hosted in a local directory domain. When you log in to a local 
account, you authenticate with that local directory domain. 

Users with local accounts typically have local home folders. When a user saves files in a 
local home folder, the files are stored locally. To save a file over the network, the user 
must connect to the network and upload the file. 

Network accounts are hosted in a network directory domain, such as a Lightweight 
Directory Access Protocol (LDAP) or Network Information Service (NIS) directory. When 
you log in to a network account, you authenticate with the network directory domain.
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